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CHAPTER 1

Chapter 1: About This Guide

This guide explains how to configure and manage NCD ThinSTAR 
Windows-based Terminals and connections to Microsoft Windows 
Terminal Servers or Citrix ICA WinFrame Servers.

Note Optional client software packages allow connections to other 
types of servers. 

This guide also explains the required and optional network services 
needed for NCD ThinSTAR terminals, and it calls attention to changes 
that occur if you also install the optional NCD ThinPATH Manager 
software. The NCD ThinPATH Manager provides the following tools, 
which are described in the documentation for the product:

Q The Configuration Tool lets you organize terminals into groups and 
set terminal properties for them remotely.

Q The Remote Restart Tool, used with the Configuration Tool, wakes 
up (Wake-on-LAN) NCD ThinSTAR 300 terminals and restarts 
NCD ThinSTAR 200 terminals and NCD ThinSTAR 300 terminals. 

Q The Web Configuration Tool lets you remotely manage all of a 
single terminal’s properties through a web page for the terminal.

Audience
This guide is for system administrators and users who maintain 
NCD ThinSTAR terminals and Windows NT servers. It assumes 
familiarity with local area networks and Microsoft Windows NT 
servers.
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About This Guide

Organization
The following chapters explain how to administer NCD ThinSTAR 
terminals.

Chapter 1: About This Guide

Describes the contents of the book and the conventions used in it.

Chapter 2: NCD Thin Client Computing

Introduces important concepts.

Chapter 3: NCD ThinSTAR Network Management

Describes network services and explains how to configure them.

Chapter 4: Terminal Startup and Setup

Explains how to start the NCD ThinSTAR and set it up initially.

Chapter 5: Connections

Explains how to add, manage, and use connections.

Chapter 6: Terminal Properties

Explains how to use Terminal Properties settings to set configuration 
values and locate system information.

Appendix A: Adding Memory to Terminals

Explains how to install memory.

Appendix B: Troubleshooting

Explains how to identify and correct problems.

Appendix C: Tips for Administration via NCD ThinPATH Manager

Summarizes the effects of installing the optional NCD ThinPATH 
Manager product for central administration. Details for the NCD 
ThinPATH Manager are in separate documentation for that product.
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About This Guide

Text Conventions
This guide uses the following text conventions:

> Indicates the movement through menu options. For 
example:

Options > Preferences

Bold Indicates a directory, file, screen element, command 
name, or key to be pressed. For example:

c:\Program Files\NCD

Bold 
monospace

Indicates user input.

Monospace Indicates information that displays on the screen. For 
example, the date command displays:

Monday May 17 03:05:12 PTD 1999

Italic Indicates a variable that you replace with specific 
information. For example, you would replace the 
following variable with the literal name of a host:

hostname

[ | ] Indicates command options. Options are separated by 
vertical bars.
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About This Guide

Related Documentation

For information on... See...

Administering Microsoft 
Windows NT, Terminal Server Edition

Microsoft documentation

Administering WinFrame and 
MetaFrame servers

Citrix documentation

Using NCD ThinSTAR terminals NCD ThinSTAR User’s Guide

Installing NCD ThinSTAR terminals NCD ThinSTAR Installation Guides

Late-breaking information NCD ThinSTAR Release Notes

Administering Microsoft 
Windows NT, Terminal Server Edition

Microsoft documentation

NCD ThinSTAR Management Service 
(TMS)

What’s This? on-line help built into the program

Tools provided with NCD ThinPATH 
Manager (Configuration Tool, Restart 
Tool, and Web Configuration Tool)

NCD ThinPATH Manager System Administrator’s 
Guide

Optional software for NCD ThinSTAR 
terminals

NCD documentation for optional software is 
available in print and at www.ncd.com. As 
appropriate, it includes online help.
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CHAPTER 2

Chapter 2: NCD Thin Client Computing

This chapter introduces NCD thin client computing and explains the 
role NCD ThinSTAR terminals play in the thin client environment. 
Topics include:

Q What Is NCD Thin Client Computing?

Q Thin Clients and Thin Client Devices

Q NCD ThinSTAR Operating Software

Q Terminal Management Options

Q Communication Sessions

Q Navigation Paths

What Is NCD Thin Client Computing?
NCD thin client computing is network computing, with users at 
terminals running applications on servers and storing files on servers.

With the base NCD ThinSTAR product, users at NCD terminals run 
Windows applications on servers with the Microsoft Windows NT 4.0, 
Terminal Server Edition operating system, the Citrix MetaFrame 
software for Terminal Server, or the Citrix WinFrame operating system. 
Additional NCD products extend access to Unix hosts and to other 
hosts through terminal emulation.
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Users do not run applications stored on their local systems and you do 
not have to manage applications on individual computers. Instead, you 
maintain applications on servers.

You also maintain control over system software for terminals, setting an 
upgrade policy for them and implementing new versions as needed. 
You select one NT server in each subnet as the Management Server and 
install NCD ThinSTAR Management Service (TMS) software on it. 
When a terminal restarts, TMS upgrades the system software 
automatically.
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NCD Thin Client Computing

Thin Clients and Thin Client Devices
A client is software that uses the resources of a server. A thin client is 
software that runs on a thin client device and allows access to resources.

A thin client device is a compact terminal that runs the Windows CE 
operating system and connects to a server that runs applications. The 
NCD ThinSTAR terminal is a thin client device.

The NCD ThinSTAR terminal stores its Operating Software in 
non-volatile memory called flash memory. Each time the terminal 
starts, it loads its Operating Software into RAM memory. It also checks 
whether this software is current and upgrades it if necessary with the 
current version on the Management Server.

When you first start a terminal, a Setup Wizard guides you through 
setting properties. Later, you can change them in Terminal Properties, 
as explained in Chapter 6.
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NCD ThinSTAR Operating Software
An NCD ThinSTAR terminal has the following Operating Software, 
which is updated by the Management Server:

Q NCD ThinSTAR boot software

The boot software provides low-level startup functions. It initializes 
and verifies correct operation of terminal hardware and starts the 
Windows CE operating system. If Operating Software on the 
terminal were to become corrupt, it would replace it with software 
from the Management Server. This is called automatic recovery.

Q NCD ThinSTAR core software

Core software includes:

— Microsoft Windows CE, a compact Microsoft operating system 
adapted for thin client devices

— NCD Windows CE device drivers

— Terminal Properties, for configuring the terminal

— The Connection Manager, for starting and managing 
connections to servers

— An SNMP agent that reports terminal properties to an SNMP 
manager on the network

— A TMS terminal component that checks for current Operating 
Software each time the terminal starts

Q Client software

Lets the terminal define and start communication sessions with a 
server. Operating software version 1.11 or later includes:

— Microsoft RDP and Citrix ICA communication protocol clients

— The NCD dial-up client, for access to the network through a 
modem
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NCD Thin Client Computing

Terminal Management Options
Each NCD ThinSTAR terminal has properties that define its 
configuration. NCD sets default values at the factory and provides the 
following ways of changing the default values:

Q NCD ThinSTAR Terminal Properties

Terminal Properties is part of the Operating Software installed on 
each terminal as part of the standard product. You can go to a 
terminal and use this software to change its properties. If desired, 
you can reset all values to factory defaults.

Q NCD ThinPATH Manager Configuration Tool

NCD ThinPATH Manager is an optional product, available for 
purchase or evaluation, that centralizes terminal management.

After installing NCD ThinPATH Manager on the Management 
Server, you, as an administrator, can manage terminals from a 
central location.

You can use the NCD ThinPATH Manager Configuration Tool to 
set properties for all terminals, a group of terminals, or one 
terminal. You save these settings in a configuration file that is 
placed on terminals when they restart and overwrites existing 
settings. You can restart terminals, if you like, using the Restart 
Tool included with NCD ThinPATH Manager.

Q NCD ThinPATH Web Configuration Tool

The Web Configuration Tool is another part NCD ThinPATH 
Manager. If passwords are used and you know the password, you 
can change a specific terminal’s properties over the web. If 
necessary, you can change the password using the NCD ThinPATH 
Manager Configuration Tool.

Q SNMP Manager

The base product provides an SNMP agent that can read properties. 
If your site uses the SNMP method of managing a network and you 
have the optional NCD ThinPATH Manager Configuration Tool, 
you can configure the SNMP agent and enable it to change terminal 
properties.
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NCD Thin Client Computing

If you have an SNMP manager, the SNMP agent on a terminal 
gives the manager data about the terminal's settings. The SNMP 
agent is read-only by default. The full list of SNMP values is in the 
NCD-THINSTAR-MIB.txt file, which is installed by default in 
the directory \Program Files\NCD\ThinSTAR Management.

You need the NCD ThinPATH Manager Configuration Tool to 
configure the SNMP agent in the NCD ThinSTAR terminal and 
allow it to change terminal settings.
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NCD Thin Client Computing

Communication Sessions
Each terminal is connected to a server (Windows Terminal Server, 
Citrix MetaFrame, or Citrix WinFrame) through a TCP/IP network. 
Clients on the terminal provide access to server resources during a 
session.

Two standard thin clients are installed on NCD ThinSTAR terminals. 
Each uses a different protocol to conduct the session.

Q The Microsoft Terminal Server client uses RDP (Remote Desktop 
Protocol) to communicate with servers running Microsoft Windows 
NT 4.0, Terminal Server Edition.

Q The Citrix ICA client uses the ICA (Independent Computing 
Architecture) protocol to communicate with a Citrix WinFrame 
Server or a Windows Terminal Server running Citrix MetaFrame.

You can conduct a remote session over a LAN or a modem. An NCD 
dial-up client establishes a network connection over a modem for an 
RDP or Citrix ICA remote session. By default, it uses PPP (the 
point-to-point protocol) to establish the connection. The Citrix ICA 
client provides either a LAN connection or a modem connection.

You add, manage, and start connections from the Connection Manager.

With NCD ThinPATH Manager, you can manage connections from a 
central location, using the Connections tab of the Configuration Tool.

As the administrator, 
you can hide the 
Configure tab so that 
users cannot change 
connections. This is a 
Terminal Properties 
option and is explained 
on page 6-30.
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Navigation Paths
After initial setup, which involves setup and connection wizards, the 
Connection Manager and Terminal Properties are the main tools you 
use to administer NCD ThinSTAR terminals. The Connection Manager 
is discussed in Chapter 5 and Terminal Properties is discussed in 
Chapter 6.

When you are in the Connection Manager, you can press F2 to go to 
Terminal Properties.

When you are in Terminal Properties, you can click OK to save and 
close Terminal Properties and return to the Connection Manager, or you 
can click Cancel to return to the Connection Manager without saving 
changes.

When you are in a communication session, you can log off, disconnect, 
or press Ctrl+Alt+End to display the Connection Manager. Pressing 
Ctrl+Alt+End leaves the connection active on the terminal. 
Disconnecting ends the connection on the terminal but leaves the 
session active on the server.

Session
Connection 

Manager
Connection 

ManagerConnect F2

OK — Saves properties and closes

Cancel — Discards changes and closes

Log Off — Closes session on server and terminal

Disconnect — Closes session on terminal and 
leaves it open on server to reconnect later

Ctrl+Alt+End — Leaves session active on server
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CHAPTER 3

Chapter 3: NCD ThinSTAR Network Management

This chapter describes the networks used in an NCD ThinSTAR 
computing environment and explains how to set up the network 
services that support NCD ThinSTAR terminals. Topics include:

Q Subnets and Domains

— Subnets

— Domains

Q Network Services

— Network Communication Using TCP/IP

— Dynamic Device Identification

— Name Resolution Services

— Remote Session Protocols

— NCD ThinSTAR Management Service (TMS)
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Subnets and Domains
Networking in an NCD ThinSTAR environment involves multiple types 
of domains and relationships between subnets and domains.

Subnets
A subnet is a physical subdivision of a network. For example, a 
company’s intranet is a subnet, connected to the internet through a 
gateway device. This subnet can have smaller subnets, each connected 
to the internet through a gateway device, and possibly also connected to 
each other through router devices.
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Domains
A domain is a logical division of a network. It is a set of systems that 
have a name and are administered as a group.

TCP/IP networks and Microsoft networks define domains differently 
and use different naming conventions. Communication over the internet 
is based on the TCP/IP protocol, so you may need to understand both 
types of domains even if your organization has a Microsoft network.

TCP/IP Internet Domains

A TCP/IP internet domain is a segment of the internet that has been 
granted a unique, official name by InterNIC, the organization that 
administers internet names and IP addresses.

Internet domains can be subdivided into subdomains and its naming 
conventions reflect this, giving the subdomain, then the domain, then 
the organization type, which can be com for commercial organizations, 
edu for educational organizations, gov for governmental organizations, 
or net for general network access.

For example, in the name acctg.biggcorp.com, acctg is a subdomain of 
the domain biggcorp, which is a commercial organization.

IP Addresses and Host Names

InterNIC gives an organization an IP address as well as a domain name. 
Every device that communicates with other devices over a TCP/IP 
network must have a unique IP address that includes the address from 
InterNIC. All IP addresses have the form nnn.nnn.nnn.nnn.

You can identify devices by their IP addresses or you can map these 
long numbers to readable names with a name resolution service. For 
example, a TCP/IP network with the DNS service can map host names 
to valid IP addresses so that users can refer to a server by its name, such 
as AP_Server, instead of its IP address.

acctg.biggcorp.com

subdomain domain organization type
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Fully Qualified Domain Names

A fully qualified domain name adds a host name to a TCP/IP domain 
name as a prefix to identify a machine across networks. For example:

 Windows NT Domains and User Authentication

A Windows NT domain is made up of servers, workstations, and other 
equipment running Windows NT. An administrator creates the domain 
and assigns it a name, for example, accounting.

The administrator creates the Windows NT domain while setting up a 
Windows NT server that authenticates users for the domain. This server 
is called the Primary Domain Controller.

When you create a connection, you choose whether users logging on to 
Windows NT servers are authenticated locally or globally.

Q With local authentication, a user logs onto a server and that server 
checks the user ID and password against its authentication 
database.

Q With global authentication, a user logs onto a server and the 
Primary Domain Controller checks the user ID and password 
against its authentication database. One database protects multiple 
servers in the same domain.

AP_server.acctg.biggcorp.com

subdomain domain organization typehost
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Network Services
In the NCD thin client computing environment, all machines require 
TCP/IP to communicate with each other. Often sites dedicate Windows 
Terminal Servers to application sessions and use a Windows NT server 
for DHCP, WINS, and DNS. The services are as follows.

Network Services

Service Status/Installation Description

TCP/IP Required. Install on all 
network machines.

All machines use this suite of protocols to 
communicate over a network.

DHCP Optional for operation; 
required for automatic 
recovery. Install on Windows 
Terminal Server or Windows 
NT server.

Each terminal must have an IP address so that the 
network can recognize it. The Dynamic Host 
Configuration Protocol (DHCP) assigns an IP 
address automatically. It can also provide network 
identifiers, such as subnet mask values, gateway 
addresses, and server addresses for DNS and WINS.

If DHCP is not available, you must assign an IP 
address at each terminal or your dial-up connection 
must provide an IP address.

DNS Optional. Install on 
Windows Terminal Server, 
Windows NT server, or 
UNIX-based server.

You can use the Domain Name System (DNS) to 
map host names to IP addresses in a static database 
for networks with UNIX hosts and mixed platforms. 
Users can then give host names instead of IP 
addresses for devices.

WINS Optional. Install on 
Windows Terminal Server or 
Windows NT server.

You can use the Windows Internet Naming Service 
(WINS) in a Microsoft Windows network to map 
host names to IP addresses. WINS updates its 
database dynamically.
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Remote 
session 
protocol

Required. Install on 
Windows Terminal Servers.

Terminals use a remote session protocol software to 
communicate with a Windows Terminal Server.

Q Servers running Windows Terminal Server 
provide the RDP protocol.

Q Servers running Citrix WinFrame or MetaFrame 
provide the ICA protocol.

TMS Optional for operation; 
required for updates, 
automatic recovery, and the 
optional NCD ThinPATH 
Manager. Install on 
Windows Terminal Server or 
Windows NT server.

The NCD ThinSTAR Management Service (TMS) 
remotely updates and recovers NCD ThinSTAR 
Operating Software, which runs locally on 
NCD ThinSTAR terminals.

SNMP Required for the optional 
NCD ThinPATH Manager.

The optional NCD ThinPATH Manager needs this 
service.

RAS

PPP

Required for NCD dial-up 
connections. Install on a 
Windows Terminal Server, 
Windows NT server, UNIX 
host, or a router.

The Microsoft RAS (Remote Access Service) and 
PPPD (point-to-point) services provide 
authentication and IP address allocation and allow 
network access for NCD dial-up connections.

Network Services (continued)

Service Status/Installation Description



NCD ThinSTAR System Administrator’s Guide 3-7

NCD ThinSTAR Network Management

Network Communication Using TCP/IP
TCP/IP must run on each server that provides services to 
NCD ThinSTAR terminals. This section describes how to configure 
TCP/IP on Windows NT servers; additional information is in the 
Microsoft help topic, “Installing and Configuring Microsoft TCP/IP.” 
For other types of hosts, refer to your system documentation for 
information on setting up TCP/IP.

Configuring TCP/IP for Windows NT 3.51

1. Select Main > Control Panel, then double click Network.

2. If TCP/IP is in the list of Installed Network Software, it is installed 
on that machine and you can skip to Step 4. If not, select Control 
Panel > Network > Add Software.

3. Select TCP/IP and related components, then select TCP/IP as an 
optional component.

4. Verify that TCP/IP is configured correctly. For information on this, 
see the Microsoft help topics, “Configuring TCP/IP” and 
“Installing TCP/IP and SNMP.”

Configuring TCP/IP for Windows NT 4.0 and Later

1. Right click Network Neighborhood, then select Properties.

2. Select the Protocols tab.

3. If TCP/IP is listed, it is installed and you can go to Step 4. If it is not 
installed, click Add, then select TCP/IP from the list of protocols 
supplied by Microsoft.

4. With TCP/IP selected on the Protocols tab, click Properties and 
select one of the following options:

— Obtain an IP address from a DHCP server

Have DHCP assign the Windows NT server an IP address.

— Specify an IP address

Manually assign a static IP address. Enter the IP address.
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Dynamic Device Identification
An NCD ThinSTAR terminal needs a valid IP address to communicate 
with other network devices. You can assign addresses manually or have 
DHCP (Dynamic Host Configuration Protocol) assign them 
automatically. DHCP can also supply a subnet mask, an IP address for 
an Internet gateway device, and IP addresses of DNS and WINS 
servers.

You must have DHCP for automatic recovery of terminal software.

You can disable DHCP for any terminal and assign it an IP address. If 
DHCP service is not on your network, you must assign IP addresses on 
every NCD ThinSTAR terminal. See Step 5 on page 4-6.

The following sections describe how to install and configure DHCP on 
a Windows NT server. For information on configuring DHCP on a 
UNIX server, see documentation for that host.

Installing the DHCP Server

This section explains how to install the DHCP server on Windows NT 
3.51 and Windows NT 4.0 and later.

Windows NT 3.51

1. Select Main > Control Panel.

2. Double click Network. 

3. If DHCP is listed under Installed Network Software, it is installed 
on that machine; go to Step 4. If not, select Control Panel > 
Network > Add Software, then select TCP/IP and related 
components.

4. From the list of optional components, select DHCP.

5. Configure DHCP as described in “Configuring the DHCP Server” 
on page 3-9.
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Windows NT 4.0 and Later

1. Select Start > Settings > Control Panel.

2. Double click Network, then go to the Services tab.

3. If Microsoft DHCP is listed, it is on the machine; go to Step 4. If 
not, click Add, then select Microsoft DHCP Server and click OK. 
Insert the requested compact disk when asked.

4. Configure DHCP as described in the next section.

Configuring the DHCP Server

1. Start the DHCP Manager.

For Windows NT 3.51, double click the DHCP Manager icon in the 
Network Administration program group.

For Windows NT 4.0 and later, select Start > 
Programs > Administrative Tools > DHCP Manager.

2. You must define a range of valid IP addresses. If none exists, select 
Scope > Create and enter the information requested.

3. You can enter information now for DHCP to give to terminals or 
enter it when configuring the terminal. To enter information now, 
select DHCP Options > Scope.

— Domain Name

The name of the TCP/IP domain where the DNS server resides.

— Router

The machine (or gateway) a subnet uses to communicates with 
another network.

— DNS Servers

The IP addresses of the DNS servers that resolve host names.

— WINS Servers

The IP addresses of the WINS servers that resolve host names.

— WINS/NBT

Allows configurable NetBIOS over TCP/IP. Set this to 0x8. 
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Name Resolution Services
If you use name resolution services, you can identify a server by its 
name instead of its IP address when you create a connection. A server’s 
name is referred to as its host name.

Windows NT hosts and NCD ThinSTAR terminals support two name 
resolution services, DNS and WINS. Both services map host names to 
IP addresses.

DNS

DNS (Domain Name System) was originally developed to map host 
names to IP addresses in UNIX-based networks. Now most operating 
systems support DNS, so it also works in mixed networks.

The DNS database is static; you must map names to IP addresses 
manually.

The internet uses the TCP/IP protocol, and DNS is based on TCP/IP 
addresses, so DNS supports name resolution across networks. You need 
DNS to resolve host names across the world-wide web.

You can set up DNS service on any Windows NT server or UNIX-based 
server in the network.

WINS

WINS (Windows Internet Naming Service) was developed for 
Microsoft networks. It is based on Microsoft’s NetBIOS device-naming 
protocol and resolves names only for Microsoft Windows-based 
machines.

Under Windows NT 4.0, WINS supports mapping of NetBIOS host 
names to IP addresses over a TCP/IP network. (In versions of 
Windows NT before 4.0, WINS maps these names to the IDs of 
machines’ network interface cards).

The WINS database is dynamic. WINS detects devices’ current IP 
addresses and automatically updates its database. Using WINS with 
DHCP fully automates IP assignment and name resolution.

You can set up WINS on any Windows NT server.
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Using DNS and WINS Together

A network can use both DNS servers and WINS servers to resolve host 
names.

If a terminal starts a connection and both services are on the network, 
the host name first goes to the DNS server to be resolved to an IP 
address. If the DNS server cannot resolve it, the name goes to the WINS 
server.

Choosing a Name Resolution Service

You can enable terminals to use DNS, or WINS, or both.

The following general guidelines suggest which services to use in your 
environment:

Use If … Additional Options

DNS You have a UNIX or 
mixed-platform environment 
or you need to create 
connections across subnets.

Use WINS also, if desired.

WINS All networked devices are 
based on Microsoft Windows 
and are in the same subnet.

Use DNS also, if desired.
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Remote Session Protocols
An NCD ThinSTAR terminal and a Windows Terminal Server 
communicate using remote session protocol software.

Terminals are preconfigured to use the Microsoft RDP remote session 
protocol. You can configure RDP on a Windows Terminal Server.

Configuring RDP on a Windows Terminal Server

Terminal Servers include the Microsoft RDP protocol with a default 
configuration.

You can modify the default RDP configuration on the Terminal Server. 
For example, you can change timeout settings or specify how the client 
responds to a broken connection. You can also modify RDP for 
individual users.

Configuring Global RDP Defaults

Global defaults affect all users logging into the Windows Terminal 
Server.

To set global RDP defaults on a Windows Terminal Server:

1. Select Start > Programs > Administrative Tools > Terminal 
Server Connection Configuration.

2. Double click the RDP-TCP connection you want to modify.

3. Click Advanced, then make the desired changes.

Configuring RDP for Individual Users

You can modify RDP settings for individual users. These individual 
settings override global defaults.

To make individual RDP settings:

1. Select Start > Programs > Administrative Tools > User 
Manager for Domains.

2. Select a user or create a new user.

3. Click Configure, then make the desired changes.
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Configuring ICA on WinFrame or MetaFrame Hosts

Servers running Citrix WinFrame or MetaFrame have the Citrix ICA 
protocol. NCD ThinSTARs are delivered with the Citrix ICA client.

To configure ICA, see the WinFrame or MetaFrame documentation. For 
global settings, see “Making Global ICA Client Settings” on page 5-21.

Configuring ICA Access to Local Printers

During a Citrix ICA session, a user can print to a printer attached to the 
serial or parallel port of an NCD ThinSTAR terminal if the server 
allows client printer mapping and the printer is mapped as explained in 
the following sections.

It is possible to print to local printers during connections to servers or 
published applications. In an application’s print command, the user 
selects the local mapped printer from the list of printers.

To map a local printer, you must associate a client name to the terminal. 
You can change the name on the Preferences tab of Global ICA Client 
Settings. The default name is the terminal’s serial number.

You must configure every Windows NT server needed for printing.

Configuring Printer Access in MetaFrame

To configure access to a local printer:

1. On the MetaFrame server, click Start on the taskbar, then select 
Settings > Printers.

2. Select a network printer.

Printers have names similar to clientname#port, where clientname 
is the name you assigned through Global ICA Client Settings and 
port is a port on the terminal, such as COM1 or LPT1.
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If no client printer is available, add one.

a. Double click the Add Printer icon in the Printers window and 
complete the screens presented.

b. Click Network printer server and double click Client.

c. Select the printer and click OK.

Terminal printer ports have names similar to clientname#port.

d. If you want this printer to be the default printer, click Yes, then 
click Next.

e. Click Finish.

Configuring Printer Access in WinFrame

To configure printing to a local printer when connected to the 
WinFrame server:

1. On the WinFrame server, in the Main program group, double click 
the Print Manager icon.

2. Select a network printer.

Note Printers have names similar to clientname#port, where 
clientname is the name you assigned in the Global ICA 
Client Settings and port is a port on the terminal; for 
example, COM1 or LPT1.

If no client printer is available:

a. From the Printer menu, click Connect to Printer.

b. In the list of shared printers, double click Client Network.

c. Double click the Client icon.

d. Select the client printer icon, which has a name similar to 
clientname#port, and click OK.

e. If you want this printer to be the default printer, select it in the 
Default menu.
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NCD ThinSTAR Management Service (TMS)
After setting up the network, you install the NCD ThinSTAR 
Management Service (TMS). This service runs on Windows NT servers 
and updates and recovers the Operating Software on NCD ThinSTAR 
terminals.

This chapter describes TMS, explains how to install TMS software, and 
describes update and recovery processes for terminals.

The Management Server

The server that runs TMS is called the Management Server. There must 
be one, and only one, Management Server per subnet. To use the same 
Management Server for multiple subnets, see “Server” on page 6-24.

TMS Functionality

TMS resides on a Windows NT server and updates terminals with the 
desired versions of NCD ThinSTAR Operating Software components. 
In the unlikely case that the Operating Software becomes corrupt, TMS 
automatically replaces it with a fresh copy.

Note If the terminal is in dial-up mode and dial-up upgrades are 
enabled, it can upgrade over a dial-up connection. However, a 
terminal cannot recover software over a dial-up connection.

TMS starts automatically when the NT server starts. It is listed as a 
service in the Control Panel and runs unless the service is disabled.

TMS upgrade policies, described on page 3-17, specify whether to 
download new software to NCD ThinSTAR terminals. In the following 
example, TMS updates the terminal with a newer version of the 
Operating Software.
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Installing TMS

In choosing an NT server for TMS installation, consider the following 
requirements for updates and automatic recovery:

Q For proper automatic operation, there must be one, and only one, 
Management Server per subnet.

Q If the terminal and the Management Server are on different subnets, 
the terminal must specify the Management Server, as explained in 
“Server” on page 6-24. Otherwise, the server cannot update the 
terminal.

Q For automatic recovery of Operating Software, DHCP must be on 
the same subnet as the Management Server.

To install TMS:

1. Insert the TMS CD-ROM into the CD-ROM drive on one of the 
following servers:

— Microsoft Windows NT 4.0 or Microsoft Windows NT 4.0, 
Terminal Server Edition. The installation program starts 
automatically. 

— Microsoft Windows NT 3.51. You must explicitly run 
setup.exe.

2. Follow instructions as the installation program guides you through 
the process.

You can specify an installation directory or use the default location, 
which is \Program Files\NCD\ThinSTAR Management.

The installation creates an NCD icon labeled ThinSTAR Manager in 
the Control Panel. On Windows NT 3.51 servers, installation creates a 
desktop program group labeled NCD ThinSTAR Management 
Service, containing an Uninstall icon and a Readme text file.
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Updates and Upgrades

When you receive an NCD ThinSTAR Operating Software update, you 
install it on the Management Server. When a terminal restarts, it gets an 
upgrade from the Management Server, if necessary, based on the 
terminal upgrade policy.

Upgrade Policies

You can select a terminal model and set the upgrade policy for each of 
its Operating Software components. The policy applies to all terminals 
of that model serviced by the Management Server.

To set the upgrade policy for each component:

1. Open the Control Panel and click the ThinSTAR Manager icon.

2. Select the terminal model, then select a component and an upgrade 
policy for it as shown in the following example, the click Close.

Upgrade Policy Description

Upgrade if not equal. TMS upgrades the terminal if the Operating 
Software on the terminal is newer or older 
than the software on the Management Server.

This lets you return to an earlier version or 
use a newer version.

Upgrade if the server 
version is newer.

TMS upgrades the terminal if the Operating 
Software on the terminal is older than the 
software on the Management Server.

The terminal always runs the latest version of 
the Operating Software kept on the 
Management Server.

This is the default value for most Operating 
Software components.

Upgrade DISABLED. TMS does not replace the terminal’s 
Operating Software under any condition.



3-18 NCD ThinSTAR System Administrator’s Guide

NCD ThinSTAR Network Management

Terminal Upgrade Process

When a terminal restarts, it displays an upgrade message while it 
replaces its Operating Software.

Context-sensitive help 
explains each item.

Q For Windows NT 
4.0, click the 
question mark 
button in the 
taskbar, then click 
the question mark 
cursor on the item. 
Click again to close 
the help window. 

Q For Windows NT 
3.51, put the cursor 
over the item and 
press F1.

Do not turn the terminal 
off during an upgrade.

Turning it off at this time 
may damage it, requiring 
a software recovery that 
will destroy the 
configuration that is 
currently defined.
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After the upgrade is complete, the terminal restarts automatically, 
without any changes to its configuration and connections.

Q If no connections have been defined, a connection wizard starts.

Q If connections have been defined, the Connection Manager starts.

The Upgrade Log

The TMS log tracks communication between a terminal and TMS and 
can be useful in troubleshooting and tracking communication between 
them. The log accumulates up to 64K bytes, then is cleared 
automatically so logging can continue. You can manually clear it at any 
time.

To view the log:

1. Open the Control Panel and click the NCD icon labeled ThinSTAR 
Manager.

2. Click View Log to display the log, then click Close to close it.

Clear empties the log and Refresh updates it with recent activity.
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Software Recovery

The NCD ThinSTAR Operating Software rarely becomes corrupted, but 
if it does, TMS provides automatic recovery. It is also possible to force 
a recovery.

Note A terminal cannot recover software over a dial-up connection.

The requirements for automatic recovery are:

Q DHCP is running on the terminal’s subnet.

Q A Management Server is on the terminal’s network.

Q The TMS upgrade policies are set to upgrade software if the version 
on the Management Server is newer.

Software recovery has the following effects:

Q The terminal restarts automatically.

Q The terminal’s configuration returns to factory defaults and the 
Setup Wizard starts so that you can change the configuration.

Q All defined connections are deleted and the connection wizard 
starts so that you can create a connection.

Automatic Recovery

When the terminal starts, it checks the software in its flash memory and 
restores it if necessary. A message announces the recovery, then the 
terminal restarts and the Setup Wizard begins.

Do not turn the terminal off during recovery.

Forced Recovery

If a terminal does not recover after an error, you can force recovery.

Note DHCP must be running for a successful recovery.

To force a recovery:

1. Restart the terminal.

2. When the progress bar appears on the logo screen, press Shift+F11.
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Disabling and Enabling TMS

By default, TMS runs automatically when the Windows NT Server 
starts. However, you may want to disable TMS if all terminals have the 
correct version of the Operating Software and you want to reduce the 
demand on the Windows NT Server.

Never disable TMS during a terminal recovery or upgrade.

To disable TMS:

1. On the Windows NT Server where TMS is installed, select the 
Services icon in the Control Panel.

2. Scroll until you see:

— ThinSTAR Management Service

— TMS File Server

3. Select each service and click Stop. 

To re-enable TMS when you want updates to resume:

1. On the Windows NT Server where TMS is installed, select the 
Services icon in the Control Panel.

2. Scroll until you see:

— ThinSTAR Management Service

— TMS File Server

3. Select each service and click Start.
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Chapter 4: Terminal Startup and Setup

This chapter explains how to start NCD ThinSTAR terminals and 
configure them one by one using the Setup Wizard. Topics include:

Q Prerequisites

Q Starting an NCD ThinSTAR Terminal

Q Configuring the Terminal at Setup

If you have the optional NCD ThinPATH Manager, you can create a list 
of managed terminals, then define groups of terminals and configure 
them with the Configuration Tool.

Prerequisites
Before using NCD ThinSTAR terminals, verify the following:

Hardware setup Terminals must be set up and physically connected to your network as 
explained in the hardware installation guide for the NCD ThinSTAR.

Windows Terminal 
Server

For connections via RDP, at least one Windows Terminal Server must 
be running on the network. For connections via ICA, at least one 
Citrix WinFrame host must be on the network or Citrix MetaFrame 
must be on a Windows Terminal Server on the network.

Router A router is needed to connect across subnets.

Applications User applications must be installed on the Windows Terminal Server.

Network services Required network services, described in Chapter 3, must be on the 
same subnet as the terminals. TCP/IP must be on all servers that 
communicate with terminals. TMS is needed to automatically update 
and recover Operating Software.
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Starting an NCD ThinSTAR Terminal
To start a terminal, turn it on. Logos appear, a chime sounds, and the 
screen briefly goes blank. The following instructions explain how to 
start different models.

If you have NCD ThinPATH Manager, you can use its Restart Tool to 
restart terminals from one central location.

After a terminal starts, the next steps depend on its state. If you have 
NCD ThinPATH Manager and have defined connections, a connection 
wizard does not appear because connections already exist.

NCD ThinSTAR Terminal Startup

Terminal Startup Procedure

NCD ThinSTAR 200 There is one power button, which is on the front panel.

NCD ThinSTAR 300 There is a power switch on the back and an on/off button on the front.

Q Leave the main power switch on the back panel in the “off” position 
while setting up terminal hardware. After installing the hardware, 
leave the power switch in the “on” position during normal operation.

Q Once the power switch on the back of the terminal is in the “on” 
position, use the power button on the front panel to turn the terminal 
on or off easily.

Steps Following Terminal Startup

When starting ... This happens ...

The first time Q The Setup Wizard guides you through terminal configuration.

Q A connection wizard lets you create an initial connection.

Q The Connection Manager starts; you can start the connection you 
created and create other connections.
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The Setup Wizard is discussed in “Configuring the Terminal at Setup” 
on page 4-4 and the connection wizard and the Connection Manager are 
discussed in Chapter 6.

After resetting to 
factory defaults in 
Terminal Properties

Q The terminal restarts automatically.

Q The Setup Wizard guides you through terminal configuration.

Q A connection wizard lets you create an initial connection.

Q The Connection Manager starts; you can start the connection you 
created or create other connections.

After upgrading 
software

Q The terminal restarts automatically.

Q If connections exist, the Connection Manager starts; otherwise, a 
connection wizard lets you create an initial connection.

After software 
recovery

Q The terminal restarts automatically.

Q The Setup Wizard guides you through terminal configuration.

Q A connection wizard lets you create an initial connection.

Q The Connection Manager starts; you can start the connection you 
created or create other connections.

Under normal 
conditions

Normally, the Configuration Manager starts when you restart a 
configured terminal that has connections defined.

However, if the terminal has been configured to automatically start a 
connection, a Windows NT logon, Windows NT desktop, or 
application starts instead. See “Setting an Autostart Connection” on 
page 5-42.

Steps Following Terminal Startup (continued)

When starting ... This happens ...
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Configuring the Terminal at Setup
The first time you start an NCD ThinSTAR terminal, the Setup Wizard 
leads you through basic configuration steps. After you have completed 
the setup procedure, you can use Terminal Properties to change the 
configuration, as described in Chapter 6.

Completing the Setup Wizard
This section explains how to provide information during setup.

Note The Setup Wizard presents only the license agreement if the 
monitor is DDC-compliant, DHCP is detected, and an NCD 
ThinPATH Manager configuration file is registered with TMS.

To complete the Setup Wizard:

1. Click Next when the Welcome appears.

2. Read the End User License Agreement, which specifies the legal 
terms governing your use of this product, then, to continue, click 
Accept.

3. Select the network connection type, then click Next.
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The terminal can connect to a server through the LAN or by dialing 
in over a modem.

4. Select a default client, then click Next.

The Connection Manager lists the default client first when you add 
a client. The default can be the Microsoft Terminal Server client, 
the Citrix ICA client, or an optional client that has been installed. 
See documentation for the optional clients for information about 
adding them to the list.

The NCD dial-up client is not a protocol client. It establishes a 
network connection via modem for protocol clients.
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5. For RDP or ICA clients, enable or disable dynamic assignment of 
IP addresses, then click Next. For dial-up clients, IP addresses are 
not requested; go to Step 8 on page 4-9.

Choose an addressing option:

— Yes, use the IP information supplied by DHCP.

If your network has DHCP, it can provide the IP address. A 
terminal gets its address and other network identifiers through 
the DHCP service by default if it is properly connected to the 
network and DHCP service is available and configured.

Go to Step 8 on page 4-9.

— No, I will enter static IP information.

You can have a specific IP address for the terminal. This option 
is selected automatically if the network does not have DHCP or 
the terminal is not properly connected to the network.

If this is selected automatically in a network with DHCP 
configured and running, the terminal cannot get its IP address 
and communicate on the network. Verify that the terminal is 
properly connected to the network, then restart the terminal. 
The Setup Wizard should detect the DHCP server and select the 
DHCP option.
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6. If you chose static IP addresses, enter them, then click Next.

— IP Address

Required. The IP address for the terminal.

— Subnet Mask

Required. The mask is calculated assuming that there are no 
subnets. If there are subnets, enter the mask for the terminal’s 
subnet.

— Gateway

Optional. The address of the machine the subnet uses to 
communicate with another network.

7. If you chose static addresses for an RDP or ICA connection, enable 
or disable DNS or WINS name resolution services and provide 
network information, then click Next.
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Windows NT hosts support both WINS and DNS name resolution 
services. The DNS server can be either a Windows NT or UNIX 
host. The selected services must be properly configured and 
available on the network, as described on page 3-10. Select either or 
both services:

— Enable DNS

— Enable WINS

Provide the following network information:

— Default Domain Name (DNS only)

The TCP/IP domain for the DNS server. If you specify a default 
domain name and a primary server IP address, users can 
identify a server by its host name.

— Primary Server IP Address

The IP address of the DNS or WINS server that resolves device 
names.

— Secondary Server IP Address

The IP address of the DNS or WINS server that resolves device 
names if the primary server cannot resolve them.
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8. Choose a display resolution and click Test to check it. When it is 
acceptable, click Next.

You can use almost any monitor with the terminal.

Newer monitors support the DDC (Display Data Channel) protocol, 
version 2.0, that lets a computer's video chip query monitors and 
adjust video settings to get the optimal desktop area and refresh rate 
the monitor supports. The screen flickers less with a higher refresh 
rate; you should specify at least 70 Hz.

With the default option, Best Available Using DDC, the terminal 
checks for a DDC 2.0-compliant monitor.

If the monitor is DDC 2.0-compliant, the terminal sets the display 
to the best resolution the monitor supports, up to a 1024 x 768 
desktop area for NCD ThinSTAR 200 terminals, up to 1600 x 1200 
for NCD ThinSTAR 300 terminals, and an 85 Hz refresh rate. If the 
monitor is DDC 2.0-compliant, but you want a specific resolution, 
select and test the resolution.
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If you select Best Available Using DDC and the monitor is not 
DDC 2.0-compliant or cannot be identified, the terminal uses 
800 x 600 and 75 Hz, but continues to display Best Available using 
DDC as the setting.

If you get the default 800 x 600 desktop, the monitor may still 
support a better resolution. To check and select a higher resolution, 
see “Display Properties” on page 6-10. If the test pattern, a 
bordered rectangular grid, is not distorted or skewed, the monitor 
supports the resolution.

After completing the setup and connection wizards, you can follow 
instructions under “Inventory Properties” on page 6-31 to see which 
resolution DDC selects.

9. To review or change previous settings, click Back, then click 
Finish to apply the settings.The terminal restarts, if necessary.

Doing a Safe Start at 640 x 480
If the monitor displays the initial logo screen when you start the 
terminal, but displays nothing after that, you can perform a safe start at 
640 x 480 at 60 Hz.

To perform a safe boot:

1. Restart the terminal.

2. When you see the blue progress bar on the logo screen, press F5 to 
boot at 640 x 480 at 60 Hz.

3. Select and test a resolution as described in Step 8 on page 4-9 or in 
“Display Properties” on page 6-10.

4. Restart the terminal.
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Next Steps
After setup, the connection wizard for the default client starts. If the 
default is a dial-up connection, the dial-up connection wizard starts 
after the client connection wizard. For information about these wizards, 
see the following sections:

Q For the Microsoft Terminal Server client, see “Adding an RDP 
Connection” on page 5-3.

Q For the Citrix ICA client, see “ICA Connections” on page 5-9.

Q For the NCD dial-up client, see “NCD Dial-Up Connections” on 
page 5-27.

Note If connections exist, the NCD ThinSTAR Connection Manager 
appears instead of a connection wizard.

After initial setup, you can use Terminal Properties to change the 
configuration, as described in Chapter 6. The Setup Wizard does not 
reappear unless the terminal performs a software recovery or you reset 
the terminal to factory defaults as described in “Resetting Values to 
Factory Defaults” on page 6-7.
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CHAPTER 5

Chapter 5: Connections

This chapter describes connections using the Microsoft Terminal Server 
client (RDP) and the Citrix ICA client. Topics include:

Q Introduction to Connections

Q RDP Connections

Q ICA Connections

Q NCD Dial-Up Connections

Q Managing Connections

Introduction to Connections
A TCP/IP network attaches terminals to a Windows Terminal Server. 
The terminals can access the server through two types of connections:

Q LAN connections

Q Modem connections

A logical connection provides a communication session between a 
terminal and a Windows Terminal Server. Two clients, each with its 
own communication protocol, provide logical connections:

Q RDP connections

The Microsoft Terminal Server client uses the RDP protocol to 
connect to a Windows Terminal Server.

Q Citrix ICA connections

The Citrix ICA client uses the ICA protocol to connect to a server 
running Citrix WinFrame or to a Windows Terminal Server running 
Citrix MetaFrame.
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The NCD dial-up client provides network transport for an RDP or ICA 
session over a modem.

You create connections with connection wizards and you administer 
them with the Connection Manager. After you configure the terminal 
with the Setup Wizard, the default client’s connection wizard is 
displayed so that you can create the first connection. After that, you can 
create other connections, including connections for other clients, with 
the Connection Manager.

The Connection Manager has a Connections tab for starting or ending 
connection sessions and a Configure tab for configuring connections:

As the administrator, you can choose whether to present the Configure 
tab. By default, it is enabled so that you can configure connections. 
However, if you want to protect this configuration, you can disable the 
tab through Terminal Properties, as described in “Clients” on page 6-30.
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RDP Connections
The Microsoft Terminal Server client uses the RDP protocol to provide 
connections.

Adding an RDP Connection
Each protocol client provides a wizard for adding connections.

To add an RDP connection:

1. Start the WTS (Windows Terminal Server) connection wizard.

After you set up the terminal with the Setup Wizard, the connection 
wizard for your default client starts so that you can define at least 
one connection. If the Microsoft Terminal Server client is the 
default, the wizard described in this section starts.

After adding the first connection, you can press Ctrl+Alt+End to 
display the Connection Manager, then start the wizard from the 
Connection Manager. To do that, select the Configure tab, click 
Add, and select the Microsoft Terminal Server client as the type of 
connection you want to create.

2. Specify a connection name and server, then click Next.
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— Name

Identify the connection, using up to 32 characters. The name 
could identify the Terminal Server, such as Lab 8, or the 
application, such as dBase or Finance.

— Server

Enter the IP address of the Terminal Server that will host the 
connection. If DNS or WINS is enabled, you can use the host 
name.

You can use the host name if a default domain was defined for 
DNS through DHCP or during setup. If no default has been 
defined or the DNS server and the terminal are in different 
TCP/IP domains, specify a fully qualified domain name.

If neither DNS nor WINS is configured, you must use the IP 
address of the server.

If the connection is to be used over a modem, you may need to 
specify the server as a fully qualified domain name or IP 
address, depending on your PPP service.

— Low Speed Connection

Select this if connecting to the server through a low bandwidth 
WAN or serial line.

3. Enable or disable automatic user logon, then click Next.
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By default, automatic user logon is disabled and users must provide 
login data when using the connection. Leave this feature disabled if 
automatic logon poses an unacceptable security risk.

To let a user log on automatically when starting this connection, 
check Automatic Logon and provide logon information:

— Username

The user ID of a local user on a particular server or a global 
user on a Domain Controller.

— Password

The password for the user ID; it is kept in encrypted form.

— Domain

The Windows NT domain name, if the server belongs to a 
Windows NT domain and the Primary Domain Controller 
authenticates users.

The name of the server if you want it to authenticate users or if 
it is not a member of a Windows NT domain.

4. Choose what to display when the connection starts, then click Next.
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Supply information as follows.

— Desktop

Display the Windows NT desktop.

— Application file name

Do not start with the Windows NT desktop. Instead, start an 
application; when the user closes this application, the 
connection ends.

Enter the directory path and file name of the application. Use 
the full path if it is not specified in the user’s environment on 
the Terminal Server host.

— Working directory

If you specified an application, you can give the path to a 
working directory. By default, the application saves data files in 
that directory.

If you do not specify a working directory, the application saves 
data files in the user’s home directory on the host. That 
directory is set in Start > Programs > Administrative Tools > 
User Manager for Domains > User > Properties > Profile.

5. Click Back to review or change previous settings, then return and 
click Finish to apply the settings.

The Connection Manager includes the new connection in its list of 
connections.

If you have just created the first connection and the terminal is in 
dial-up mode, the NCD dial-up client’s connection wizard starts. 
See “Adding an NCD Dial-Up Connection” on page 5-27.
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Starting an RDP Connection
You start connections from the Connection Manager, which lists all 
connections on its Connections tab. You can press Ctrl+Alt+End to 
display the Connection Manager.

A terminal must be in the correct mode—LAN or dial-up—to start a 
connection. To change the mode, see “Network” on page 6-26.

To start an RDP connection:

1. In the Connection Manager, select the Connections tab, then 
double click the name or select the name and click Connect.

If the connection was correctly defined, and the server is running, 
the connection starts.

If the terminal cannot connect, select the Configure tab. Correct the 
server specification for the connection if it is wrong, then try to 
connect again.

If you have the right server, see whether it is running and check 
whether the terminal is physically connected to the network. You 
can use the Management > Network > Diagnostics tab in 
Terminal Properties to do this. For information, see “Test Network 
Connections” on page 6-28.
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2. Enter logon information—user name, password, and domain—if 
requested, then click OK. A connection may require logging on 
manually or the user information in an automatic logon connection 
may be wrong or may not be authenticated for that server.

The connection starts the specified application or the server’s 
desktop, depending on startup options set in Step 4 on page 5-5.

Stopping an RDP Connection
You can stop connections by logging off the Windows NT desktop or 
suspend them by quitting the Windows application. A suspended 
connection or application continues to uses server resources, so some 
sites discourage disconnecting.

Logging Off

On the Windows NT desktop, select Start > Logoff to close open 
applications, then log off and end the connection.

Disconnecting

On the Windows NT desktop, select Start > Disconnect to log off and 
end the connection, but leave open applications running in a suspended 
state. When you reconnect to the server, the applications are in the same 
state as when you disconnected. It may be convenient to disconnect, but 
applications left running may place excessive demands on the server.
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ICA Connections
The Citrix ICA client provides both network and dial-in connections 
using the ICA protocol. It does not support modem callback.

Adding an ICA Network Connection
Each protocol client provides a wizard for adding connections.

To create an ICA connection:

1. Start the connection wizard.

If the Citrix ICA client is the default client, its connection wizard 
starts after you complete the Setup Wizard so that you can define 
one connection.

After adding the first connection, you can press Ctrl+Alt+End to 
display the Connection Manager, then start the wizard from the 
Connection Manager. To start the wizard, select the Configure tab 
and click Add. Select the Citrix ICA client as the type of 
connection.

2. Select Network Connection as the connection type and click Next.
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3. Select a server or published application and click Next.

The lists depend on the global ICA client settings in Terminal 
Properties, as described on page 5-21. By default, they include 
servers or published applications in the local network.

The client uses the primary Citrix server to build the lists. To build 
the first list, it does an auto-locate broadcast and uses the first ICA 
server browser that responds.

If servers or published applications do not appear and you think 
they should, click Refresh to update the lists. For example, you 
may need to do this in the following situations:

— A server or published application does not appear because the 
network had a temporary problem or a server was down.

— You have just added or deleted servers.

— You have just added a server on another subnet in one of the 
server locations.



NCD ThinSTAR System Administrator’s Guide 5-11

Connections

Addresses on Remote Networks

To list servers and published applications on remote networks, click 
Server Location, edit the list, and click OK.

The default address, Auto-Locate, lists servers and published 
applications on the local network only.

You can use the following buttons to edit the list:

— Add

To add servers or published applications on a remote network, 
click Add, then enter the name or IP address of a server that 
maintains the list of servers on the remote network. ICA 
browsing is not supported in dial-up mode.

— Delete

To delete a server from the list, select it and click Delete.

— Move Up/Move Down

To reorder the list, use the Move Up and Move Down buttons. 
The first server is the primary server and is consulted first to 
build lists of servers and published applications. The second 
server is consulted next, and so on.

— Default List

The last saved list is the default list. To replace the current list 
with the default list, click Default List and click Yes.
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4. Choose what to display when the connection starts, then click Next.

To start with the Windows desktop, leave this information blank.

To start with an application, enter the following information:

— Command Line

Enter the path and name of the application. During the session, 
you can run only this application. When you quit the 
application, the session ends.

— Working Directory

Enter the drive and path of the working directory (optional).

This associates the directory with the application; when you 
access a file from the application, the application uses the 
working directory by default. For example, commands in the 
application’s File menu operate, by default, on files in the 
working directory.
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5. Specify logon information, then click Next.

If you enter a valid user name, password, and server domain, it is 
used for an automatic logon.

If you leave any of these fields blank, the connection prompts for 
all of the information.

For published applications, the logon information must be valid for 
the server running the published application. If the connection is to 
an anonymous published application, the logon information is 
ignored.

6. Choose whether to use 16 colors or 256 colors for the desktop or 
application, then click Next.

A dial-up connection may be faster with 16 colors.

The default number of colors displayed is affected by the global 
ICA client settings you can make in Terminal Properties. For more 
information, see page 5-21.
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7. Specify compression and sound, then click Next.

Provide information as follows:

— Compress Data Stream

Enable or disable data compression. Enabling compression 
reduces the amount of data transferred between the terminal 
and server but increase the load on the server.

Disabling compression reduces the load on the server but 
transfers more data. With a high speed LAN, compression may 
be unnecessary.

— Cache

Not supported in this release.

— Enable Sound 

Allows applications to play sound on the terminal.

— Sound Quality

If sound is enabled, set sound quality. The higher the quality 
level, the greater the bandwidth consumption.

Medium is recommended for LAN-based connections.

Low is recommended for low-bandwidth connections, 
including modem connections.
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8. Specify a title for the connection.

By default, the server or published application name is displayed. 
To specify a different title, backspace through the default name and 
type another name.

9. Click Finish to save the connection, then click OK.

After you finish defining the connection, the new connection is 
included in the list of connections in the Connection Manager.

If the terminal is in dial-up mode and you have just created the first 
protocol connection, the NCD dial-up client connection wizard 
starts. See page 5-27.
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Adding an ICA Dial-In Connection
For a connection over a modem, you can add an ICA dial-in connection.

This requires configuring the ICA dial-in server. See the 
WinFrame/MetaFrame documentation for instructions.

The NCD dial-up client provides an alternative way of adding a 
connection over a modem. To use this method, identify the ICA 
connection as a network connection and set dial-up options as described 
in “Adding an NCD Dial-Up Connection” on page 5-27.

To create an ICA dial-in connection:

1. Start the connection wizard.

If the Citrix ICA client is the default client, its connection wizard 
starts after you set up the terminal so that you can define one 
connection.

2. After adding the first connection, you can press Ctrl+Alt +End to 
display the Connection Manager, then start the wizard from it. To 
start the wizard, select the Configure tab, click Add. Select the 
Citrix ICA client as the type of connection.

3. Select Dial-In Connection as the connection type and click Next.
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4. Provide modem information, then click Next.

Provide information as follows:

— Dial-In Device

Select a modem. Hayes Compatible is the only type supported.

— Area

The area code of the number to dial. For future use.

— Phone Number

The complete phone number (long distance access, country 
code, area code, and phone number), with or without hyphens.

— Country

For future use.

— Use Area and Country Codes

For future use.

Click Configure if you want to configure port settings and call 
options (see Step 4 on page 5-29 for definitions), then click OK.
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5. Choose what to display when the connection starts, then click Next.

To start with the Windows desktop, leave this information blank.

To start with an application, enter the following information:

— Command Line

Enter the path and name of the application. During the session, 
you can run only this application. When you quit the 
application, the session ends.

— Working Directory

Enter the drive and path of the working directory (optional).

This associates the directory with the application; when you 
access a file from the application, the application uses the 
working directory by default. For example, commands in the 
application’s File menu operate, by default, on files in the 
working directory.



NCD ThinSTAR System Administrator’s Guide 5-19

Connections

6. Specify logon information, then click Next.

If you enter a valid user name, password, and server domain, the 
information is used for an automatic logon.

If you leave any of these fields blank, the connection prompts for 
all of the information.

For published applications, the logon information must be valid for 
the server running the published application. Logon information is 
ignored for an anonymous published application.

7. Choose whether to use 16 colors or 256 colors for the desktop or 
application, then click Next.

A dial-up connection may be faster with 16 colors.

The default number of colors displayed is affected by the global 
ICA client settings you can make in Terminal Properties. For more 
information, see page 5-21.
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8. Specify compression and sound, then click Next.

Provide information as follows:

— Compress Data Stream

Enabling compression reduces the amount of data transferred 
between the terminal and server, but increases the load on the 
server. Disabling compression reduces the load on the server, 
but increases the amount of data transferred. With a high speed 
LAN, compression may be unnecessary.

— Cache

This feature is not supported in this release.

— Enable Sound 

This allows applications to play sound on the terminal.

— Sound Quality

Select a sound quality level. More bandwidth is required for 
higher levels.

Medium is recommended for LAN-based connections.

Low is recommended for low-bandwidth connections, 
including modem connections.
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9. Specify a title for the connection, then click Finish.

The Connection Manager lists the new connection.

Making Global ICA Client Settings
In Terminal Properties, you can define default settings for all ICA client 
connections. You can override some of these settings when you create 
an ICA connection.

To set global settings for the ICA client:

1. From the Connection Manager, press F2 to start Terminal 
Properties.

2. Select Management > Client.

3. Select the Citrix ICA client beside the Configure Client button, 
then click the button.

4. Make global ICA client settings on any or all of the following tabs, 
then click OK to save your changes or click X to cancel them:

— Default Hotkeys

— Preferences

— Server Location
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Default Hotkeys

The Citrix ICA client provides hotkeys for basic functions during 
ICA sessions. Some affect the ICA client; others emulate standard 
Microsoft Windows key sequences.

Default values for the ICA client hotkeys are as follows.

Function Default 
Hotkeys

Description

Status Ctrl+6 Displays the status of the connection.

Close 
application

Ctrl+2 Disconnects the ICA client from the server and closes the client 
window on the terminal desktop, leaving the ICA session running 
in a disconnected state on the server. To avoid this, log off instead 
of using the hotkey.

Toggle title bar Ctrl+3 Hides or displays the window title bar.

Ctrl+Alt+Del Ctrl+4 Sends the standard Windows Ctrl+Alt+Del to the server. Displays 
the Windows NT Security information.

Ctrl+Esc Ctrl+5 Sends the standard Windows Ctrl+Esc to the server. The remote 
Task List appears on WinFrame servers; the Windows NT Start 
menu appears on MetaFrame servers.

Alt+Esc Ctrl+7 Sends the standard Windows Alt+Esc to the server. Cycles 
through minimized icons and open windows of open applications.

Alt+Tab Ctrl+8 Sends the standard Windows Alt+Tab to the server. Cycles 
through open applications, displaying programs.

Alt+Backtab Ctrtl+9 Cycles through open applications in reverse order.
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Default Preferences

Provide data as follows.

— Serial Number

Leave this empty.

— Default Window Colors

Check 16 or 256 colors. NCD ThinSTAR terminals use up to 
256 colors. Low-bandwidth connections, such as most modem 
connections, may perform better with 16 colors.

— Enable Palette Device

 Always checked.

— Client Name

The terminal name used when a printer is attached to the 
terminal during an ICA session. For details, see “Configuring 
ICA Access to Local Printers” on page 3-13.

— Allow Automatic Client Updates

For future use.
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Server Location

The ICA client uses this data to locate servers and published 
applications when you create or edit an ICA connection.

Auto-Locate, the default value, causes the ICA client to seek only 
the servers and published applications on the local network when 
you create a connection.

You can use the following buttons to edit the list:

— Add

To include servers and published applications on remote 
networks, such as those on the other side of a gateway, click 
Add, then enter the name or IP address of a server that tracks 
servers on the remote network and click OK.

— Delete

To delete a server from the list, select it and click Delete.

— Move Up/Move Down

To reorder the list, use the Move Up and Move Down buttons. 
The first server listed is the primary server and is consulted first 
to build the list of servers and published applications. Then the 
next server is consulted, and so on.

— Default List

The list saved last is the default list. To replace the current list 
with the default list, click Default List, then click Yes.
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Starting an ICA Connection
You start connections from the Connection Manager, which lists all 
connections on its Connections tab. If the Connection Manager is not 
displayed, press Ctrl+Alt+End.

A terminal must be in the correct mode—LAN or dial-up—to start a 
connection. To change the mode, see “Network” on page 6-26.

1. In the Connection Manager, select the Connections tab, then 
double click the connection or select the connection and click 
Connect.

If the connection was correctly defined and the server is running, 
the connection starts.

If the terminal cannot connect, select the Configure tab. Correct the 
server specification for the connection if it is wrong, then try to 
connect again. If you have the right server, see whether it is running 
and check whether the terminal is physically connected to the 
network. For more information, see “Test Network Connections” 
on page 6-28.
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2. Enter logon information—user name, password, and domain—if 
requested, then click OK. A connection may require logging on 
manually or the user information in an automatic logon connection 
may be wrong or may not be authenticated for that server.

The connection starts the specified application or the server’s 
desktop, depending on startup options set in Step 4 on page 5-12.

Stopping an ICA Connection
This section explains how to end or disconnect ICA connections. 
Disconnecting suspends the connection and leaves it executing on the 
server; you can reconnect to the session later and resume any tasks left 
running. Since the connection continues to use server resources, some 
administrators prefer to have users log off.

Logging Off

On WinFrame servers, in the Program Manager, select File > Logoff, 
then click OK to confirm.

On MetaFrame servers, select Start >Logoff.

Disconnecting

On WinFrame servers, in the Program Manager, select File > 
Disconnect, then click OK to confirm.

On MetaFrame servers, select Start >Logoff.
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NCD Dial-Up Connections
The dial-up client provides a network connection over a modem. Once 
the connection is established, a protocol client connection (RDP, for 
example) can start. Therefore, you must configure both a dial-up 
connection and a connection for an RDP client, ICA client, or an 
optional installed protocol client.

After you complete the Setup Wizard, the terminal starts the appropriate 
connection wizard (RDP or ICA) if no connection exists. It then starts 
the NCD dial-up connection wizard.

Note The NCD dial-up client does not support modem callback.

If you want to connect to an ICA session over a modem you have two 
choices:

Q You can create an ICA dial-in connection as described in “Adding 
an ICA Dial-In Connection” on page 5-16.

Q You can create an NCD dial-up connection, then create an ICA 
network connection to use over the dial-up line.

Adding an NCD Dial-Up Connection
This section explains how to create an NCD dial-up connection.

To add an NCD dial-up connection using the NCD dial-up client:

1. Start the connection wizard.

If you select the dial-up client as the default when configuring the 
terminal, the dial-up connection wizard starts after you create an 
RDP or ICA connection so you can configure the dial-up 
connection.

If connections exist and you want to add more, go to the Configure 
tab of the Connection Manager and click Add, then select the NCD 
dial-up client.
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2. Specify the connection name and click Next.

The name could identify the host or the application. It can have up 
to 20 characters when you are defining the connection. If you edit 
the connection from the Connection Manager, the name can be 
extended to 32 characters.

3. Select a modem.

Currently, only Hayes-compatible modems are supported.
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4. Click Configure to configure the port settings and call options and 
click OK.

Provide information for Port Settings as follows.

— Manual Dial

If this is enabled, the user can enter data and modem commands 
in a separate window when dialing. The manual dialing 
window is provided by the Microsoft Windows RAS/TAPI 
subsystem. If manual dialing is disabled, the NCD dial-up 
client dials the phone number and no window is displayed.

— Terminals

Use terminal window before dialing

If this is enabled, the user can enter modem commands before 
dialing the host computer.

Use terminal window after dialing

If this is enabled, the user can enter commands to the host 
computer after dialing is complete.

— Connection Preferences

Choose values as follows.

The following serial port parameters (baud rate, data bits, 
parity, and stop bits) determine the characteristics of the 
connection between the terminal and the modem and are 
automatically sensed by the modem. The modem uses these 
parameters to define the format of the data that it sends to the 
host and expects from the host.
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Baud Rate—Determines the upper limit of the speed of the 
connection between the modem and the host. Select the highest 
speed available on the terminal’s modem; the modem does not 
negotiate a connection higher than the baud rate you specify.

Data Bits—The number of data bits generated by the terminal 
and expected by the host.

Parity—The type of parity generated by the terminal and 
expected by the host.

Stop Bits—The number of stop bits generated by the terminal 
and expected by the host.

Flow Control—The type of flow control handshaking used on 
the terminal’s serial port and expected by the host. You can 
select one of the following:

If you choose Hardware, hardware handshaking, also called 
DTR/DSR, is used.

If you choose Software, the terminal sends an XOFF (^S) 
character when the input buffer space is low and an XON (^Q) 
character when input buffer space is available. This is not 
recommended because noise on the line can introduce spurious 
XOFF characters than can cause the connection to freeze.

If you choose None, there is no flow control handshaking.
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Provide information for Call Options as follows.

— Call Setup

Use these options as follows.

Cancel the call if not connected within seconds—This option 
cancels the call if it is not completed within the specified time. 
Set this to the amount of time you are willing to wait for the 
connection to occur.

Wait for dial tone before dialing—When this is enabled, the 
call does not go through until there is a dial tone. Disable this if 
you are making a direct serial connection between two modems 
and not using the phone line. With such a connection, there is 
never a dial tone.

Wait for credit card tone seconds—This option waits for the 
specified time before continuing the call to allow time for 
entering a credit card number.

— Extra Settings

You can enter modem commands here to override the default 
settings; for example, to turn on local echo, enter ‘E1’.
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5. Click TCP/IP Settings to configure TCP/IP, then click OK.

Supply information on the General tab as follows:

— Server-assigned address

Select this item if your dial-in host supplies the terminal with 
an IP address. Uncheck this box and fill in the IP address field 
if the host does not supply an IP address. You may want to 
assign an address (if allowed by the server) for long-term, 
dedicated dial-up connections.

— Use SLIP

Enable this option if the dial-up server does not support the 
default protocol, PPP.

— Use software compression

Compression speeds up data transmission; however, it can only 
be used if the terminal and the host use compatible compression 
methods. It should not be necessary to disable this option.

— Use IP header compression

Compression speeds up data transmission; however, it can only 
be used if the terminal and the host use compatible compression 
methods. It should not be necessary to disable this option.
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Supply information on the Name Servers tab as follows:

— Server-assigned addresses

Causes the dial-up client to accept from the dial-in server the IP 
addresses of the hosts providing name service.

Select this option if your dial-in host gives the terminal name 
resolution parameters. Disable this option and enter the DNS 
and/or WINS name server host addresses if the PPP host does 
not give name server information or if you want to use different 
name server hosts.

— Primary and Secondary DNS

The IP address of the first DNS server to resolve device names 
and the IP address of the DNS server to resolve device names if 
the primary server cannot.

— Primary and Secondary WINS

The IP address of the first WINS server to resolve device 
names and the IP address of the WINS server to resolve device 
names routed if the primary server cannot.

6. Click Next.



5-34 NCD ThinSTAR System Administrator’s Guide

Connections

7. Specify the telephone number to dial and click Next.

Type the complete phone number of the modem on the dial-in 
server; using up to 128 characters. For example:

9-1-650-555-1212

Note Hyphens are not required. Remove them, if necessary, to 
remain within the 128-character limit.

Selecting a Startup Session for an NCD Dial-Up Connection
You can have a connection start automatically once the dial-up network 
connection is established. The list includes all of the protocol 
connections (RDP or ICA) that you have created.

If no protocol session is selected, the user selects a protocol connection 
after starting the dial-up connection from the Connection Manager.

To specify the protocol connection to start and other options:

1. Select a protocol connection or <none>.
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2. To automatically close the dial-up connection when the user logs 
off or disconnects from the protocol session, enable Close dial-up 
connection at session end. Otherwise, the dial-up connection 
remains open and the user can select another protocol session. 

3. To erase the saved user name and password, click Forget 
Password.

When the connection is first created, this option is not available. 
The user can enable it by saving the user name and password after 
starting the connection. For more information about saving the user 
name and password, see “Starting an NCD Dial-Up Connection” on 
page 5-35. Depending on your environment, saving the password 
may be an unacceptable security risk.

4. Click Next.

5. To review or change settings, click Back. To apply the settings, 
click Finish.

The new connection is included in the list of connections in the 
Connection Manager.

Starting an NCD Dial-Up Connection
The terminal must be in dial-up mode as described in “Network” on 
page 6-26.

To start a dial-up connection, using the NCD dial-up client:

1. Press Ctrl+Alt+End to display the Connection Manager.

2. On the Connections tab of the Connection Manager, double click 
the connection name or select the connection and click Connect.

If the connection was correctly defined, and the server is running, 
the connection starts.

If the terminal cannot connect, select the Configure tab. Correct the 
dialing specification for the connection if it is wrong, then try to 
connect again.
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3. The first time you use a dial-up connection, you must log in. You 
can click Save Password if you do not want to enter it the next time 
you start the connection.

Note If saving the password introduces an unacceptable security 
risk, you can edit the dial-up connection and enable Forget 
Password. See “Selecting a Startup Session for an NCD 
Dial-Up Connection” on page 5-34 for more information.

4. Begin a protocol connection session.

If a startup session is defined for the connection, it starts 
automatically.

If none is defined, press Ctrl+Alt+End to display the Connection 
Manager, select a protocol connection, and click Connect.

5. Enter logon information—user name, password, and domain—if 
requested, then click OK.

The connection starts the specified application or the server’s 
desktop, depending on startup options.

A connection may require 
logging on manually or the 
user information in an 
automatic logon connection 
may be wrong or may not 
be authenticated for that 
server.
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Stopping an NCD Dial-Up Connection
How you stop the dial-up connection depends on how it is configured.

Managing Connections
The Configure tab of the Connection Manager has options for 
performing the following functions:

Q Adding connections

Q Editing connections

Q Deleting connections

Q Stopping connections

Q Setting a connection as the default or setting it to start automatically

The Connection Manager is on the terminal screen when no connection 
is running. To display it when a connection is running, press 
Ctrl+Alt+End.

By default, the Configure tab is displayed, making it easy to set up 
connections on a terminal. After you have created connections, you can 
hide the Configure tab to preserve the connections. Instructions are on 
page 6-30.

Configuration Setup How you stop

Close dial-up connection 
at session end is enabled.

Log off or disconnect from the application host. The connection 
stops automatically, then the dial-up session ends.

Close dial-up connection 
at session end is disabled 
or no startup session was 
selected.

Log off or disconnect from the application host, then click 
Disconnect to stop the dial-up connection when prompted.

You can also highlight the active dial-up session in the Connection 
Manager and click End.
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Adding a Connection in the Connection Manager
After you have created one connection as part of the startup process, 
you can use the Connection Manager to create new connections.

To add connections:

1. On the Configure tab of the Connection Manager, click Add.

2. Select the type of connection, then click OK. The list includes 
optional clients that you have installed.

3. If the client software provides a wizard or utility for defining a new 
connection (most do), it starts now.

For the Microsoft Terminal Server client, see page 5-3. For the 
Citrix ICA client, see page 5-9. For an NCD dial-up client, see page 
5-27.
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Editing a Connection in the Connection Manager
To modify the properties of a connection:

1. On the Configure tab of the Connection Manager, select the 
desired connection.

2. Click Edit and make changes.

Edit mode and the connection wizard may present properties 
differently. For example, properties for an RDP connection appear 
as follows:

For the Microsoft Terminal Server client, see page 5-3. For the 
Citrix ICA client, see page 5-9. For the NCD dial-up client, see 
page 5-27.

Deleting a Connection in the Connection Manager
To delete an existing connection:

1. On the Configure tab of the Connection Manager, select the 
connection you want to delete.

2. Click Delete and confirm that you want to delete the connection.
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Stopping a Connection from the Connection Manager
It is best to disconnect or log off from the host desktop or the 
application, but you can also stop a connection from the Connection 
Manager.

Note To disconnect or log off, see “Stopping an RDP Connection” on 
page 5-8, “Stopping an ICA Connection” on page 5-26, or 
“Stopping an NCD Dial-Up Connection” on page 5-37.

1. Select the Connections tab of the Connection Manager.

2. Select the active connection and click End, then click OK when 
prompted to confirm that you want to disconnect.

If you do not respond or there is a problem with the Windows 
session, click End Task when prompted to terminate the 
connection immediately.

A connections that is 
running has active status.

The End button 
disconnects (suspends) 
connections, but leaves 
them running on the server, 
using resources. For this 
reason, administrators 
often prefer to have users 
log off.
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Setting Startup Options in the Connection Manager
You can select one connection as either the default connection or as an 
autostart connection. The default connection is automatically 
highlighted in the Connection Manager when you restart a terminal; an 
autostart connection starts automatically when a terminal restarts.

Setting a Default Connection

The default connection is the one highlighted when you display the 
Connection Manager.You can start the default connection, or switch to 
it, by pressing Ctrl+Alt+Home.

One connection can be the default connection. If you set a connection as 
an autostart connection, it automatically becomes the default.

To set a connection as the default:

1. On the Configure tab of the Connection Manager, select the 
connection you want to have as the default.

2. Click Startup.

3. Select Make the selected connection your default connection and 
click OK.
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Setting an Autostart Connection

You can configure a connection to start automatically when you restart 
the terminal.

When you log off, the autostart connection restarts immediately. If this 
happens and you want to stop it, see page 5-43.

A dial-up connection must specify a protocol connection as well for 
true automated startup, or it is necessary to start the protocol connection 
manually at logon.

Configuring a connection to start automatically makes it the default 
connection. If you later make another connection the default, the 
original autostart connection no longer starts automatically.

To configure a connection to start automatically:

1. On the Configure tab of the Connection Manager, select the 
connection you want to start automatically.

2. Click Startup, then select Automatically start the selected 
connection at startup and click OK.

The autostart connection fails unless it corresponds to the terminal’s 
network connection mode—LAN or dial-up.

If you need to change the mode, see “Network” on page 6-26.
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Stopping an Autostart Connection

An autostart connection restarts as soon as you close the Windows NT 
desktop or log off. To prevent this, set the connection as the default 
connection rather than the autostart connection.

To stop the autostart connection:

1. While the autostart connection is active, press Ctrl+Alt+End to go 
to the Connection Manager.

2. Select the Configure tab.

3. Click Startup.

4. Select Make the selected connection your default connection and 
click OK.

5. To return to your running connection, select the Connections tab 
and select the active connection.

6. Click Connect.
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CHAPTER 6

Chapter 6: Terminal Properties

This chapter discusses terminal properties, which are configuration 
values for NCD ThinSTAR terminals. Topics include:

Q Introduction to Terminal Properties

— Access to Terminal Properties

— Password Protection

— Saving or Ignoring Changes and Exiting

— Keyboard Navigation

Q Resetting Values to Factory Defaults

Q Input Properties

Q Display Properties

Q Network Properties

Q Management Properties

— Security

— Pointer

— Audio

— Touchscreen

— Server

— Hotkeys

— Network

— Power

— Clients

Q Inventory Properties
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Introduction to Terminal Properties
You define essential properties when you configure a terminal with the 
Setup Wizard. This wizard, described in Chapter 4, appears when you 
first start a terminal, reset factory defaults, or recover software.

After setup, you can view and modify settings through Terminal 
Properties, as described in this chapter. If you have the optional NCD 
ThinPATH product, you can modify settings for groups of terminals 
from one central location.

Terminal Properties presents all configuration values and hardware, 
software, and network inventory details in one place. The information is 
organized on the following tabs:

Q General — identifies the product and provides an option for 
resetting all configured values to factory defaults.

Q Input — has settings for the keyboard and the mouse.

Q Display — has settings for the monitor, including resolution, 
refresh rate, and a screen saver.

Q Network — has basic settings for network addresses.

Q Management — has additional tabs with settings for security, 
pointer speed, audio, touchscreen (available on the 
NCD ThinSTAR 300), the Management Server, hotkeys, network, 
monitor power, and clients. The network information on the 
Management tab provides additional networking options and 
includes diagnostics.

Q Inventory — has additional tabs with information, such as the 
version number, for hardware, software, the network, and graphics.
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Access to Terminal Properties
To display Terminal Properties, press Ctrl+Alt+End to go to the NCD 
ThinSTAR Connection Manager, then press F2.

Password Protection
You can protect the terminal’s configuration by setting a password. If a 
password exists, a user can see terminal properties, but must enter the 
password to change any properties except those on the following tabs: 
Input, Display, Management > Pointer, Management > Audio, 
Management > Power, and Management > Touchscreen.

Security options are discussed on page 6-15.

F2

Ctrl+Alt+End 
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Saving or Ignoring Changes and Exiting
After viewing or modifying configuration settings, you can save or 
cancel changes and exit.

The Apply button, the OK button, and the Cancel button perform these 
functions, as follows:

A suggested practice is to use the Apply button to apply changes on 
each tab, then to use the OK button when you are ready to exit Terminal 
Properties.

Button Result

Apply Saves changes and remains in Terminal Properties.

OK Saves changes and closes Terminal Properties.

Cancel Closes Terminal Properties. Any changes that you did 
not apply are lost.



NCD ThinSTAR System Administrator’s Guide 6-5

Terminal Properties

Keyboard Navigation
You can use the keyboard to navigate within Terminal Properties. When 
you are on a tab name, you can use the Alt key with an underlined letter 
to go to a property and change its value.

Going to a Property or Button

Q Going to a slider moves the cursor one unit lower or higher. For 
example, for Volume, Alt+L moves the cursor one unit lower and 
Alt+H moves the cursor one unit higher.

Q Going to a checkbox toggles its value. For example, if the Enable 
box is checked, using Alt+E disables the property.

Q Going to a button activates the button. For example, Alt+A goes to 
the Apply button and applies changes.
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Once you are in a property, you can use the underlined letter without 
Alt to go to properties or buttons on the same tab. For example, in 
Volume, you can press T to activate the Test button. This shortcut is not 
available for list boxes or fields that allow you to edit information.

Cycling Through Tabs, Properties, and Buttons

You can press the Tab key to cycle down through a main property tab 
and its contents or press the Shift+Tab key to go in reverse tab order.

For example, from the Management > Audio tab, you can press Tab to 
go through rows of tabs, properties, and buttons as follows: Audio tab, 
Volume field, Mute button, Test button, Enable button, OK button, 
Cancel button, Apply button (if you made any changes). After cycling 
down, you start back up at the Management tab.
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Resetting Values to Factory Defaults
NCD has set default configuration values for a terminal, and you can 
restore them. Any connections that you have created are lost.

To reset factory default values:

1. In Terminal Properties, select General.

2. Check Reset and click OK.

3. Answer Yes when asked about restarting the terminal.

Restarting the terminal starts the Setup Wizard, which is described 
in Chapter 4.

The factory defaults are as follows.

NCD ThinSTAR Factory Default System Settings

Terminal Software Attribute Default Setting

Connection Manager Connection List No connections.

Configure > Add Lists only Microsoft Terminal Server client and 
Citrix ICA client. Optional clients are removed.

SNMP Agent Read/write mode Read only mode.

Optional Software Installation status Not installed.

NCD ThinSTAR Factory Default Property Settings

Tab Attribute Default Setting

Input Keyboard English (United States).

Mouse Right-handed.

Character Repeat The shortest delay; midway between the fastest and 
slowest rate.
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Display Desktop Area and 
Refresh Frequency

Best Available Using DDC.

Screen Saver Enabled, with a timeout of 20 minutes.

Network IP Address Get an address from a DHCP server. Existing IP address 
entries are removed.

Advanced

Network

Enable DNS Filled with data from DHCP.

Enable WINS Filled with data from DHCP.

Management Security No password.

Pointer Speed Four units above slow.

Audio High volume.

Microphone disabled (not on NCD ThinSTAR 200).

Touchscreen Disabled.

Server Blank.

Hotkeys Enabled.

Network LAN connection; network speed sensed automatically.

DHCP timeout of 60 seconds. Management Server 
timeout of 5 seconds.

Host resolution timeout of 5 seconds. Send count of 5.

Power No settings.

Clients Microsoft Terminal Server Client.

English (United States) locale.

Configure tab of Connection Manager enabled.

Inventory Network 
information

Reports IP address changes caused by reset to defaults on 
Network tab and Display tab.

NCD ThinSTAR Factory Default Property Settings (continued)

Tab Attribute Default Setting
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Input Properties
On the Input tab, you can select a keyboard locale, modify mouse 
button actions, and set character repeat options.

1. In Terminal Properties, select the Input tab.

2. Modify properties as desired, then click OK or Apply to put them 
into effect.

— Keyboard

Select a keyboard type from the list of locales.

— Mouse

Select Right-handed or Left-handed.

— Character Repeat

Move the Repeat delay slider to specify how long to wait 
before a pressed key starts repeating.

Move the Repeat rate slider to specify how quickly the 
character repeats when you press a key.
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Display Properties
Display properties include screen resolution and the screen saver.

To set display properties:

1. In Terminal Properties, select Display.

2. Modify attributes as desired, then click OK or Apply.

— Desktop Area and Refresh Frequency

The default, Best Available Using DDC, automatically 
establishes the optimal setting, as described in Step 8 on page 
4-9. If you choose another setting, click Test to check it. If the 
grid is not displayed or is distorted, click No when asked, then 
try another setting. When the grid is acceptable, click Yes.

— Enable Screen Saver

By default, the monitor displays a blank screen saver after the 
terminal is idle for a set time. You can enable this or disable it.

— Wait n Minutes

The number of minutes the terminal is idle before the screen 
saver is used. The default is 20; the maximum is 300.

If you restart the terminal and 
the screen goes blank after 
the logo, settings are 
incorrect. See “Unreadable 
Display” on page B-2.

Properties defined on the 
Management > Power tab 
and discussed on page 6-29, 
can reduce power use even 
more than the screen saver.
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Network Properties
Every terminal needs a valid IP address to identify itself to the network. 
NCD ThinSTAR terminals support dynamic IP assignment through 
DHCP or manual assignment of a static IP address. If you choose static 
addresses, you can make name resolution choices as well.

If the terminal is in dial-up mode, IP information comes from the 
dial-up connection, so you cannot select DHCP or enter static IP 
addresses. However, any settings you make when the terminal is in 
LAN mode are preserved. (To change the network connection mode, 
see “Network” on page 6-26.)

If the terminal uses DHCP, you cannot change values that DHCP 
supplies, but you can change other values.

To choose an addressing mode:

1. In Terminal Properties, select Network.
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2. Select an addressing mode and provide information as needed, then 
click Apply or OK.

— Obtain an IP address from a DHCP server

DHCP is enabled by default and provides an IP address each 
time the terminal starts. 

— Specify an IP address

As an alternative to DHCP, you can assign the terminal’s IP 
address and other addresses.

IP Address. Required. Identifies the terminal.

Subnet Mask. Required. Identifies the range of addresses that 
belong to the subnet.

Gateway. Optional. The machine a subnet uses to 
communicate with another network.

If you specify an IP address, the Advanced Network button is 
enabled so that you can specify how the system resolves host 
names to IP addresses for a connection. If you want to do this, 
click the button and provide information for either or both 
services, then click OK.
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Enable DNS. Use the Domain Name System to resolve host 
names. If DHCP provides IP addresses, it also provides DNS 
information. Enable DNS only if you know that your network 
provides it and you have the DNS server’s host name and IP 
addresses. The DNS server can be a Windows NT server or a 
UNIX host.

Enable WINS. Use the Windows Internet Naming Service 
(WINS) to resolve host names. If DHCP provides IP 
information, it also provides WINS information.

Provide information for these services as follows:

Default Domain. This applies only to DNS and shows which 
TCP/IP domain the DNS server resides in.

Primary Server IP Address. The IP address of the DNS or 
WINS server that is to resolve device names. Windows NT 
includes WINS, but it must be properly configured. Enabling 
WINS here assumes this has been done as described on page 
3-10.

Secondary Server IP Address. The IP address of the DNS or 
WINS server that is to resolve a device name if the primary 
server cannot resolve it.
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Management Properties
The Management tab is organized into a series of tabs that you can use 
to set properties and perform actions such as tests:

Management Properties

Main Tab Properties/Functionality

Security Create, enter, change, or delete a password.

Protect terminal property changes by using a password.

Pointer Adjust the speed of the pointer.

Audio Set the volume level or choose to mute sounds.

Test the volume.

Enable the microphone (not on NCD ThinSTAR 200 terminal).

Touchscreen Enable touchscreen, for monitors that support the feature.

Identify the port for the touchscreen monitor.

Calibrate the screen.

Server Select a Management Server to provide updates to the terminal.

Hotkeys Enable hotkeys to cycle through connections.

Network Specify the type (LAN or dial-up) and speed.

Set timeouts for DHCP and the Management Server.

Perform diagnostics.

Power Provide power information for monitors.

Clients Set a default client.

Configure a client.

Choose a terminal locale.

Enable or disable the Configure tab in the Connection Manager.
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Security
To increase security, you can require users to enter a password to 
change some properties. You can also control which tabs and properties 
users can change.

Create a Password

To create a password:

1. In Terminal Properties, select Management > Security. If no 
password exists, this tab contains the Create Password tab.

2. Enter the password in the Password field. Enter it exactly in the 
Confirm password field and press Enter or click Create. The 
password now exists; it is not necessary to click OK or Apply to 
save it.

As soon as the password is created, the Create Password tab is 
replaced by the Change Password and Terminal Properties 
Access tabs.

If you enter characters in the Password, then leave the tab without 
completing the process, the terminal warns you when you try to exit 
Terminal Properties.
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Enter the Password

If a password exists, the Management > Security tab displays the 
Enter Password tab.

To enter the password:

1. Type the password in the Password field.

2. Click the Enter button or press the Enter key.

The Security tab now displays the Change Password tab and 
Terminal Properties Access tab. You can change the password, if 
desired, or go to another tab.



NCD ThinSTAR System Administrator’s Guide 6-17

Terminal Properties

Change the Password

To change the current password:

1. In Terminal Properties, select Management > Security > Enter 
Password and enter the password.

After you enter the password, the Change Password tab and the 
Terminal Properties Access tab replace the Enter Password tab.

2. If the Old password field is blank, enter the old password and press 
Enter. The Old password field is filled in (and displays asterisks) 
if you have just created a new password.

3. Enter a new password in the New password field and press Enter.

4. Enter the same password exactly in the Confirm password field 
and press Enter.

5. Click Change or press Enter.

A message lets you know that the password was changed.

If you enter characters in the New password field, then leave the 
tab without completing the process, the terminal warns you when 
you try to exit Terminal Properties.
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Delete the Password

To delete the current password:

1. In Terminal Properties, select Management > Security > Enter 
Password and enter the password.

After you enter the password, the Change Password tab and the 
Terminal Properties Access tab replace the Enter Password tab.

2. Enter the current password in the Old Password field and leave the 
other fields blank.

3. Click Change.

When the password is deleted, the screen displays the Create 
Password tab. At this point, you can go to another tab or click OK 
to exit Terminal Properties.

Define Access to Individual Tabs and Properties

Using the Terminal Properties password, you can protect fields and tabs 
from changes. By default, if you create a password and the user does 
not enter it, the user can change only the fields on the following tabs:

Q The Input tab

Q The Display tab

Q The Management > Pointer tab

Q The Management > Audio tab

Q The Management > Touchscreen tab (NCD ThinSTAR 300)

Q The Management > Power tab

A user can always change fields after entering the password.

You can change these defaults through the Management > Terminal 
Properties Access tab. This tab appears only if you are using a 
password.
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To configure access to fields and tabs:

1. In Terminal Properties, create a password as described on page 6-15 
or enter the password as described on page 6-16.

2. In Terminal Properties, select Management > Security > 
Terminal Properties Access.

3. Set access properties, then click OK or Apply.

Each line in the Properties list identifies a field or tab and shows its 
protection status.

— If the Protected status for a field or tab is set to Yes, a user 
must enter the password to access it; if the user does not enter 
the password, the field is grayed out.

— If the Protected status is No, the user has access to the field or 
tab without entering a password.

To change protection status, select one or more items and click 
Protect or Unprotect.

To reset all fields to their default protection status, click Set All to 
Defaults.
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Pointer
You can change how fast the mouse pointer moves on the desktop when 
you move the mouse.

To set the pointer speed:

1. In Terminal Properties, select Management > Pointer.

2. Use the slider to select a speed, then click Apply and move the 
mouse to test the speed, If you want to return to the default speed 
(the fourth mark), click Default, then click OK or Apply.
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Audio
The Audio tab has options for terminal speakers and microphone input.

To configure audio:

1. In Terminal Properties, select Management > Audio.
l

2. Set properties, then click OK or Apply.

— Speaker Volume

Use the slider to set the volume of the speakers, then click Test 
to hear the volume at that setting.

— Speaker Mute

Mute turns audio on or off.

— Microphone Enable

Enable enables or disables microphone input. By default, the 
microphone is disabled. (This is not available for 
NCD ThinSTAR 200 terminals.)
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Touchscreen
If your monitor supports touch input, you can enable touchscreen. This 
disables mouse input and removes mouse and pointer options from the 
Input and Pointer tabs. (The NCD ThinSTAR 200 model does not 
support touchscreen.)

To set touchscreen properties:

1. In Terminal Properties, select Management > Touchscreen.

2. Set properties, then click OK or Apply.

— Enable

You can enable or disable touchscreen.

— Select COM port to which you have connected the 
touchscreen

If you enable touchscreen, specify the communications (COM) 
port. The touchscreen must be connected to the port with a 
serial cable.

If you enable touchscreen 
and do not have a 
touchscreen monitor or 
enter the wrong COM port, 
see page B-4.
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3. Restart the terminal to put touchscreen into effect.

When the terminal restarts, the calibration program runs if you have 
not yet calibrated for the current display resolution. Follow 
instructions presented to define the corners of your screen.

4. Return to the Management > Touchscreen tab and click Calibrate 
to calibrate the touchscreen. Follow instructions presented to define 
the corners of your screen.

If you selected the wrong port or switched from a touchscreen to a 
non-touchscreen monitor, see recovery procedures in “Calibration 
Program for Touchscreen Times Out” on page B-3.
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Server
The NCD ThinSTAR Management Service (TMS), automatically 
updates NCD ThinSTAR Operating Software on terminals. It can be 
installed on any Windows NT server in the network. By default, the 
terminal broadcasts on the terminal’s subnet to locate the Management 
Server. However, you may want to use a specific Management Server 
on a different subnet.

To choose a Management Server for software updates:

1. In Terminal Properties, select Management > Server.

2. Enter the IP address of the Management Server that is to update the 
Operating Software on this terminal, then click Apply or OK.

If name resolution service is available, you can use the host name. 
If you have specified a gateway, you can specify the Management 
Server on a different subnet.
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Hotkeys
You can enable hotkeys so that users can use the following key 
sequences to switch connections during a running session.

To enable connection hot keys:

1. In Terminal Properties, select Management > Hotkeys.

2. Select Enable Connection Hotkeys, then click Apply or OK.

Hot Key Use

Ctrl+Alt+n� Cycle up through active connections in the 
Connection Manager.

Ctrl+Alt+p Cycle down through active connections in the 
Connection Manager.

Ctrl+Alt+Home Go to the default connection.The connection is 
started if it is not already active.
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Network
The terminal can communicate over a modem or over a LAN. For a 
LAN, you can specify the network speed or have the terminal sense it.

Network Connection Type

To set the network connection type and options:

1. In Terminal Properties, select Management > Network > Type.

2. Select a type and provide information, then click OK or Apply.

— LAN Connection

For a LAN connection, select a network speed option. NCD 
recommends Automatically Sense Network Speed. (100 
Mbps is unavailable on NCD ThinSTAR 200s.)

— Dial-Up Connection

For a dial-up network connection, choose whether to allow 
software upgrades over the modem. It may not be desirable to 
allow upgrades over the modem because of the time required to 
download files.

3. Restart the terminal to apply these changes.
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Set Timeouts

You can specify timeout values that determine how long the terminal 
waits for information from the DHCP or Management Server. You may 
need to extend default timeout values if you are on a switched network 
using the spanning tree protocol.

To specify timeouts:

1. In Terminal Properties, select Management > Network > 
Timeouts.

2. Enter timeout information, then click Apply or OK.

— DHCP Timeout

The default is 60 seconds. If the terminal restarts in DHCP 
network mode and DHCP information is not available, a timer 
counts down from the timeout value until the server responds or 
you click Cancel.

— Management Server Timeout

The default is 5 seconds. If the timeout value is more than 5 
seconds and the restarted terminal cannot contact the 
Management Server, a timer counts down from the timeout 
value until the server responds or you click Cancel.

Default restores the default 
value, 60 seconds.

Default restores the default 
value, 5 seconds.
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Test Network Connections

You can send a ping command to test the connection to a network host.

To test the connection:

1. In Terminal Properties, select Management > Network > 
Diagnostics.

2. Enter diagnostic information:

— Host Resolution Timeout

Specify how long to wait for host resolution after you click 
Ping. The default is 5 seconds.

— Send Count

Enter the number of times to ping the host.

— Host to Ping

Enter the host name or IP address.

3. Click Ping to test the connection. Status information includes a 
Cancel button you can click to end the test. If the terminal reaches 
the host, the host replies. If not, one or more error messages appear.

4. Click OK or Apply.
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Power
Power settings go beyond screen savers (page 6-10) in reducing power 
use.

To make power settings:

1. In Terminal Properties, select Management > Power.

2. Enter power information for the monitor, then click OK or Apply.

— Monitor is Energy Star compliant

For a DDC monitor, the terminal sets this and you cannot 
change it. For other monitors, specify whether it is Energy Star 
compliant. You can set timeouts for an Energy Star compliant 
monitor, using the following formula:

— Suspend Timeout. Turns off some power, but lets you activate 
the screen quickly. Give the number of minutes before the 
suspend state begins.

— Powerdown Timeout. Turns off most power, but leaves the 
mouse and keyboard active. Give the number of minutes before 
powerdown begins. It takes several seconds longer to return 
from powerdown state than from suspend state.

The screen saver timeout 
cannot exceed the suspend 
timeout and the suspend 
timeout cannot exceed the 
powerdown timeout.

Screen Saver Timeout <= Suspend Timeout <= Powerdown Timeout
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Clients
On the Clients tab, you can set a default client, configure some clients, 
set the terminal locale, and enable the ability to configure connections.

To set client properties:

1. In Terminal Properties, select Management > Clients.

2. Enter information, then click OK or Apply.

— Set Default Client

The Connection Manager lists this client first in add mode.

— Configure Client

Select a client. If this button is available, you can click it to set 
options for the client. Citrix ICA settings are on page 5-21.

— Terminal Locale

The language your terminal uses to communicate with the 
Windows Terminal Server.

— Display Connection Manager’s Configure Tab

By default, the Configure tab of the Connection Manager is 
visible so you can set up connections, but you can hide the tab.

Properties for some clients 
can be set through Terminal 
Properties. If you can set 
global options for the client 
here, the Configure Client 
button is available.
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Inventory Properties
The Inventory tab has additional tabs with information about the 
terminal’s hardware, software, the network, and graphics. It also has an 
About tab.

To view inventory properties:

1. In Terminal Properties, select Inventory.

The information on the Inventory tab can be useful for verifying 
hardware and software versions, confirming a successful software 
upgrade, and reporting problems to NCD Technical Support.

The Hardware tab has the following information:
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The Software tab has tabs for system information and installed 
software, including optional software such as terminal emulations.
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The Network Settings tab has three tabs, showing addresses, name 
services, and miscellaneous information.

The Addresses tab shows network addresses:

If the terminal is in dial-up mode, the IP address shown is the 
address returned from the dial-up connection. The dial-up network 
protocol (PPP or SLIP) supplies this address.
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The Name Services tab shows which servers provide name 
resolution service for DNS and WINS name services.

The Misc. tab shows miscellaneous information, including the 
connection type and network speed.
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The Graphics tab has the following information.

The About tab has the following information for an 
NCD ThinSTAR 300 terminal.
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APPENDIX A

Appendix A: Adding Memory to Terminals

This appendix provides memory specifications, shows how to install 
memory in an NCD ThinSTAR 200 or 300 terminal, and explains how 
to test memory. Topics include:

Q Installing Memory—NCD ThinSTAR 200

— SIMM Specifications—NCD ThinSTAR 200

— Installation Procedures

— Verifying Memory

Q Installing Memory—NCD ThinSTAR 300

— DIMM Specifications—NCD ThinSTAR 300

— Installation Procedures

— Verifying Memory
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Installing Memory—NCD ThinSTAR 200
This section describes the installation of an 8 MB, 16 MB, or 32 MB 
SIMM (Single In-line Memory Module) in an NCD ThinSTAR 200 
terminal.

In the standard configuration, the terminal contains 8 MB of built-in 
EDO memory and one SIMM slot for memory expansion.

You can order terminals either with no SIMM or with an 8 MB SIMM 
in the slot. You can remove an existing 8 MB SIMM and replace it with 
a 16 MB or 32 MB SIMM or insert either an 8 MB, 16 MB, or 32 MB 
SIMM in the empty slot. The maximum memory that an NCD 
ThinSTAR 200 can use is 32 MB. If you use a 32 MB EDO SIMM in 
the slot, the terminal does not use the built-in 8 MB EDO memory.

You can buy SIMMs from NCD or other vendors. Contact NCD 
Technical Support for information about approved vendors. Only 
SIMMs supplied by NCD are covered under NCD’s warranty.

SIMM Specifications—NCD ThinSTAR 200
SIMM specifications are as follows.

Mode EDO mode. You must install EDO SIMMs in the NCD 
ThinSTAR 200.

Speed 60 nanoseconds (ns) or faster (Lower ns ratings are 
faster.)

Profile Tin-plated 72-pin SIMM contacts

Low profile (maximum 1.1 inches (28 mm) tall) 

Board 
Thickness

0.047 inches to 0.054 inches (0.050 inches (1.27 mm) 
nominal). Installing SIMMs that are out of specifications 
might damage the SIMM slot or cause the terminal to 
behave erratically.

Size 32-bits wide 

8 MB (2Mx32 SIMM) – or – 16 MB (4Mx32 SIMM)
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Installation Procedures
This section explains how to install additional memory. The only tool 
you need is a small flat-blade screwdriver.

Note If you do not feel confident performing the following procedure 
on your terminal, send the terminal to a qualified service center.

To install additional memory: 

1. Disassemble the terminal. See “Disassembling the Base” on page 
A-12. 

2. Install the SIMM. See “Installing the SIMM” on page A-5.

3. Reassemble the terminal. See “Reassembling the Space-Saver 
Base” on page A-8. 

4. Test the memory after your terminal is up and running. See 
“Verifying Memory” on page A-9.

Disassembling the Base

To disassemble the base:

1. Turn off power to the terminal.

2. Remove all cables connected to the terminal.

3. If you are using the stand, remove the terminal from the stand. 

4. Place the terminal on a flat surface (preferably, on an antistatic mat) 
with the top facing up. As you face the terminal, the three 
connectors are on your right.
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5. Use a small flat-blade screwdriver to press inwards on the tab 
located near the back of the terminal on the connector-side. At the 
same time, gently pull the terminal’s top section up.

 

6. Repeat Step 5 for the tab on the opposite side of the base.
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7. Lift the top section at the front up so that you can separate the top’s 
hooks from the bottom section’s slots. Remove the top.

Installing the SIMM

This section explains how to install the SIMM.

Electrostatic Discharge (ESD) can damage SIMMs and other 
components located on the logic board. Make sure you touch a suitable 
ground before handling any SIMM. If possible, set the terminal on an 
antistatic mat and wear a grounding strap.

Always handle SIMMs only by the edges.
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The SIMM slot, located on the left side of the logic board, is labeled J9.

To install the SIMM in the NCD ThinSTAR 200 terminal:

1. Orient the SIMM so that the notch faces the back of the logic board.

2. Insert the SIMM into the slot at a 45-degree angle.

3. When the SIMM is inserted all the way, press down on both ends 
until it clicks into place. The SIMM should go past the metal tabs 
on each end of the slot.

The SIMM should lie at a 25- to 30-degree angle in the slot.

SIMM slot J9 

Notch

SIMM
Slot
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Removing the SIMM

To remove the SIMM:

1. Use your forefingers or thumbs to pull back on the two metal tabs 
located on each end of the SIMM slot.

 

2. As you pull back on the tabs, the SIMM pops up past the metal tabs.
 

3. Hold the SIMM on both ends and remove it from the slot.

Metal tab

Metal tabs

Hold SIMMs on edges
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Reassembling the Space-Saver Base

To reassemble the terminal:

1. Swing the front of the top section over the front edge of the bottom 
section and continue down, placing the hooks on the top section in 
the slots on the bottom.

2. Gently press the top section down until the two tabs click through 
the two openings on the bottom section.

3. Install the cabling.

4. After the system is installed, perform the memory test. (See 
“Verifying Memory” on page A-9.)

Make sure the top section is 
resting completely aligned on 
the bottom section before 
going to Step 2.
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Verifying Memory
To verify memory in the NCD ThinSTAR 200 terminal:

1. Install the terminal as described in the NCD ThinSTAR 200 
Installation Guide.

2. Restart the terminal and complete the restart process, which 
includes memory testing.

3. Press Ctrl+Alt+End to display the NCD ThinSTAR Connection 
Manager.

4. Press F2 to display Terminal Properties.

5. Select the Inventory > Hardware tab.

This lists the base memory, which should always be 8 MB and the 
SIMM memory, which should reflect the SIMM installed.

If the terminal does not start or display memory in the Inventory > 
Hardware tab after you restart it, verify that the SIMM is properly 
seated.
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Installing Memory—NCD ThinSTAR 300
The NCD ThinSTAR 300 terminal has two 168-pin DIMM slots for 
optional SDRAM (synchronous dynamic random access memory) 
DIMMs. The maximum total memory that an NCD ThinSTAR 300 
terminal can use is 32 MB. Your terminal comes with 16 MB.

You can remove the existing DIMM and replace it with a 32-MB 
DIMM or insert a 16-MB DIMM in the empty slot at any time.

DIMM Specifications—NCD ThinSTAR 300
DIMM specifications are as follows.

NCD ThinSTAR 300 DIMM Specifications

Mode Synchronous dynamic random access memory (SDRAM)

Unbuffered

Non-ECC (error correcting code)/parity

Speed grade 66 MHz or faster

CAS latency 3 or less

Voltage 3.3 Volts

Profile 168-pin DIMM contacts

Maximum 1.25 inches (31.75 mm tall) 

Gold-plated fingers

Board thickness 0.047 inches to 0.054 inches (0.050 inches [1.27 mm] nominal)

Installing DIMMs that are outside specification might damage the 
DIMM slot or cause the terminal to behave erratically.

Intel references SDRAM DIMMs must conform to the following Intel specifications:

PC SDRAM, Version 1.1

4-Clock 66 MHz Unbuffered SDRAM DIMM, Revision 1.0

PC SDRAM Serial Presence Detect (SPC), Revision 1.2A
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Installation Procedures

If you do not feel confident performing the following procedure on your 
terminal, send the terminal to a qualified service center.

Installing additional memory is a four-step procedure, which is 
described in detail on the following pages.

The only tool you need is a small flat-blade screwdriver.

To install additional memory:

1. Disassemble the terminal. See “Disassembling the Base” on page 
A-12. 

2. Install the DIMM(s). See “Installing DIMMs” on page A-15. 

3. Reassemble the terminal. See “Reassembling the Base” on page 
A-17. 

4. Test the memory after your terminal is up and running. See 
“Verifying Memory” on page A-18.

Sizes Use only the following sizes of SDRAMs: 

One bank:

2 Megabit x 64 bits = 16 Megabytes

4 Megabit x 64 bits = 32 Megabytes

Two banks:

2 Megabit x 64 bits = 16 Megabytes

4 Megabit x 64 bits = 32 Megabytes

The number of banks on a DIMM refers to the internal operation of its 
address rows. See the manufacturer’s data sheet; the manufacturer’s 
DIMM part number indicates the number of banks. The number of 
banks is unrelated to whether there are memory chips on one or both 
sides of a DIMM.

NCD ThinSTAR 300 DIMM Specifications (continued)
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Disassembling the Base

An electric shock is possible if the power supply is exposed with the 
line cord in place. You must remove the line cord before removing the 
top cover.

To disassemble the base:

1. Use the rear power switch to turn off power, and remove the line 
cord.

2. Remove all cables connected to the base.

3. Place the base with the top up and the front facing you (preferably, 
on an antistatic mat).

4. Use your finger to release the large clip on the underside of the 
front panel and remove the panel by prying on the top of the panel 
to release several small clips.
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5. Use a small flat-blade screwdriver to remove the screw located on 
the front of the terminal, as shown in the insert. Then remove the 
clip from its slot.

 

Clip

Screw
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6. Use a small flat-blade screwdriver to release the two tabs located on 
the front of the terminal.

7. Carefully lift the top section up at the front so you can slide the 
top’s rear tabs from the bottom section’s slots to separate the cover 
from the bottom.

Lift the top section up at the front only until you can slide the 
top’s rear tabs from the bottom section’s slots. If you lift the 
top section too high, the tabs can break.

 

Tab

Slot
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Installing DIMMs

Electrostatic Discharge (ESD) can damage DIMMs and other 
components located on the logic board. Make sure you touch a suitable 
ground before handling any DIMM. If possible, set the terminal on an 
antistatic mat and wear a grounding strap.

Never touch the connector pins when you handle DIMMs.

Your terminal already has a DIMM installed. The DIMM slots, located 
on the front of the logic board, are labeled J13 and J14.

S

If you are replacing a 16 MB DIMM with a 32 MB DIMM, you need to 
remove the existing DIMM. Read “Removing DIMMs” on page A-17 
and then return to this section for installation instructions.

 DIMM slot J14 
DIMM slot J13
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To install DIMMs in an NCD ThinSTAR 300 terminal:

1. Orient the DIMM so that the key will fit into the slot’s pin.
 

2. If necessary, push the two plastic lock/ejection levers located on 
each end of the DIMM slot outwards. Firmly insert the DIMM into 
the slot and push the lock/ejection levers inwards to lock the 
DIMM.

 

Key

DIMM

Slot

DIMM slot
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Removing DIMMs

To remove a DIMM:

1. Push outwards on the two plastic lock/ejection levers located on 
each end of the DIMM slot. The DIMM will eject from the slot.

 

2. Remove the DIMM from the slot. Do not touch the connector pins.

Reassembling the Base

To reassemble the base:

1. Swing the back of the top section over the back edge of the bottom 
section and align the three rear tabs on the top section with the slots 
on the bottom section.

 

2. Lower the front of the top section until the three rear tabs slide 
through the three slots on the bottom section.

Plastic lock/ejection levers

Tab

Slot
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3. Replace the clip and the screw as shown in the insert.
 

4. Replace the front panel.

5. Install the cabling.

6. After the system is installed, perform the memory test described in 
the next section.

Verifying Memory
The terminal must be installed before you can test the memory. After 
installation, perform the following steps:

1. Power the terminal up.

2. The Connection Manager window displays. If it does not, press 
Ctrl+Alt+End.

3. Press F2 to display the NCD ThinSTARTerminal Properties.

4. Select the Inventory > Hardware tab. It reports DIMM1 and 
DIMM2 memory.

If the terminal does not boot or the reported memory is incorrect when 
you restart the terminal, verify that the DIMM is properly seated.

Clip

Screw
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Appendix B: Troubleshooting

This appendix covers problems that may occur with NCD ThinSTAR 
terminals and suggests strategies for resolving them.

This appendix also lists the flashes, tones, and messages that terminals 
produce under various conditions, and explains what action you should 
take in each case.

Topics include:

Q Problems and Solutions

— Unreadable Display

— Terminal Does Not Operate

— Calibration Program for Touchscreen Times Out

— Network Screen Appears at Startup

— Terminal’s Operating Software Is Not Upgraded

Q Error Codes and Messages

— Boot Error Alert Tones

— Boot Error Flashes

— Error and Status Messages
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Problems and Solutions
This section describes the most common problems and offers solutions.

Unreadable Display
If the monitor displays the initial logo screen at power-on, but nothing 
after that, the desktop area and refresh frequency setting for the monitor 
is wrong.

If this occurs, you need to start the terminal in safe boot mode, which is 
640 x 480 at 60 Hz. To do this, restart the terminal, then press F5 when 
you see the progress bar on the logo screen.

The monitor may support a better desktop area (resolution) and 
frequency than the default setting. To try alternate monitor settings, 
follow the instructions in “Display Properties” on page 6-10.

You can also try alternate monitor settings if the terminal restarts the 
Setup Wizard. (See Step 8 on page 4-9.)

Terminal Does Not Operate
If a terminal stops operating and restarting it does not solve the 
problem, you may need to force software recovery.

To force the recovery:

1. Turn the power to the terminal off, then on.

2. Press Shift+F11 when you see the progress bar on the logo screen.

Details on recovering software are in “Forced Recovery” on page 3-20.
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Calibration Program for Touchscreen Times Out
In touchscreen mode, the calibration program runs when a new display 
resolution is selected and the terminal restarts. Two errors may cause 
the touchscreen calibration program to time out.

No Touchscreen Monitor

If you switch from a touchscreen to a non-touchscreen monitor, the 
calibration program times out after 30 seconds.

To correct this:

1. You can wait for the calibration timeout or press Esc to cancel the 
calibration program.

2. When the calibration program ends, press F2 to return to Terminal 
Properties.

3. Use the right arrow key to move to the Management tab, then press 
Tab to go to the Management > Security tab. Use the right arrow 
key to move to the Touchscreen tab.

4. Press Alt+E to disable touchscreen.

5. Press Alt+A to apply the changes.

6. Restart the terminal.
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Wrong COM Port

If you have the wrong COM port:

1. If the physical connection is wrong, connect the serial cable to the 
other COM port on the terminal. 

2. You can wait for the calibration timeout or press Esc to cancel the 
calibration program.

3. When the calibration program ends, press F2 to return to Terminal 
Properties.

4. Use the right arrow key to move to the Management tab, then press 
Tab to go to the Management > Security tab. Use the right arrow 
key to move to the Touchscreen tab.

5. Press Alt+S to go to the list of COM ports, then use the up or down 
arrow to select another port.

6. Press Alt+A to apply the changes.

7. Restart the terminal.

Network Screen Appears at Startup
At startup, a terminal checks for network accessibility and availability 
of IP addresses. If the cable is not secure, the terminal cannot determine 
the necessary network addresses, or the terminal is in the wrong 
network connection mode, the Network screen appears.

Disconnected Network Cable

Check the network cable connection at the terminal and at the outlet on 
the wall or hub. If the cable is not secure, plug it in and click Restart in 
the Network screen. The terminal should restart normally.
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Fixing an Address Problem

If the cable is plugged in securely, the problem may be that the terminal 
cannot find the required network identifiers. 

To check how the terminal is configured for network identifiers:

1. In the Network screen, click Manage Network Options.

2. In Terminal Properties, select the Network tab.

— If the terminal is configured to use DHCP, make sure DHCP is 
properly configured on the server.

— If the terminal uses static IP addresses, make sure it is 
configured with the correct identifiers.

3. Click OK. The terminal restarts.

Note See Chapter 6 for more information on using Terminal 
Properties.

Waiting for a Network Address

If the terminal is in DHCP mode and the DHCP server does not 
respond, a displayed timer counts down from the DHCP timeout value 
until DHCP server does respond to the terminal with network 
information. Click Cancel and then Advanced Setup to adjust your 
network settings or increase the DHCP timeout value as described in 
“Set Timeouts” on page 6-27.

Changing from LAN Use to Dial-up Use

If the terminal is in LAN mode and you do not switch it to dial-up mode 
before taking it off the LAN and attaching it to a modem, the Network 
screen appears when you start the terminal.

To switch the terminal to dial-up mode:

1. In the Network screen, click Manage Network Options.

2. When the Management tab of Terminal Properties appears, click 
Network Options.

3. Enable Dial-Up Connection.
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4. Click OK. The terminal restarts in dial-up mode.

Terminal’s Operating Software Is Not Upgraded
If the terminal does not receive new software from TMS, check your 
Management Server and its upgrade policies. Check the policies and 
compare the software version and build numbers with the versions 
shown on the Terminal Properties > Inventory > Software tab to see 
whether the software should be upgraded.

On a switched network using the spanning tree protocol, increase the 
Management Server timeout as described in “Set Timeouts” on page 
6-27.

Error Codes and Messages
This section lists error codes and messages for NCD ThinSTAR 
terminals and offers recommendations for actions to take.

Boot Error Alert Tones
The following table lists boot software errors that are signaled by a 
series of tones from the terminal. For example, the tone pattern 3-2-4 
means three tones, pause, two tones, pause, four tones.

Boot Error Alert Tones

Tone Pattern Description Recommended Actions

3-2-4 Keyboard controller failed Try a different keyboard. If error 
persists, contact NCD Technical 
Support.

3-4-1 Video subsystem failure Contact NCD Technical Support.
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Boot Error Flashes
The following table lists bootstrap errors that are signaled by a series of 
flashes punctuated with a short pause from the LED light on the front of 
the terminal.

Error and Status Messages
The following table explains the error and status messages that can 
appear on the terminal’s monitor.

Boot Error Flashes

Flashes Description Recovery Recommendations

1 Video controller initialization failed Contact NCD Technical Support.

2 Video memory test failed Contact NCD Technical Support.

Error and Status Messages

Message Description Recommended Action

RE000000 STARTING 
USER FORCED 
RECOVERY

STATUS MESSAGE: Recovery 
mechanism was initiated by holding 
down SHIFT+F11. 

No action.

RE000001 RECOVERY 
ATTEMPT STARTED

STATUS MESSAGE: Flash file 
system failed during a read 
operation. Recovery mechanism 
started.

No action.

RE000002 RECOVERY 
ATTEMPT DHCP

STATUS MESSAGE: Flash file 
system failed during a read 
operation. Recovery mechanism has 
begun, using DHCP to get an IP 
address.

No action.
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RE000003 RECOVERY 
ATTEMPT 
BROADCAST

STATUS MESSAGE: Flash file 
system failed during a read 
operation. Recovery mechanism 
started; broadcasting to find a 
Windows NT server running TMS.

No action.

RE000004 RECOVERY 
ATTEMPT RETRY ###

STATUS MESSAGE: Flash file 
system failed during a read 
operation. Recovery mechanism 
re-broadcasting to find a 
Windows NT server running TMS.

No action.

RE000005 RECOVERY 
ATTEMPT FAILED TO 
CONNECT

Flash file system failed during a read 
operation. Failed to find a 
Windows NT server running TMS. 
The terminal stops operating.

Make sure TMS is running 
on a Windows NT server in 
the same subnet as the 
terminal.

RE000006 RECOVERY 
ATTEMPT: CONNECT

STATUS MESSAGE: Successful 
connection to a Windows NT server 
running TMS.

No action.

RE000007 RECOVERY 
ATTEMPT: LOADING

STATUS MESSAGE: Flash file 
system failed during a read 
operation. A fresh copy of the 
Operating Software is being 
downloaded.

No action.

RE000008 RECOVERY 
ATTEMPT: FAILED 
LOAD

File system hardware failed during a 
read operation. An attempt to 
download a fresh copy of the 
Operating Software failed due to 
incorrect format or a transmission 
error.

1. Retry recovery by 
restarting the terminal.

2. Re-install TMS on the 
Windows NT server, then 
restart the terminal.

Error and Status Messages (continued)

Message Description Recommended Action
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RE000009 RECOVERY 
ATTEMPT: 
EXECUTING

STATUS MESSAGE: Flash file 
system failed during a read 
operation. Executing recovery code. 
Control has passed from Boot 
Software to Windows CE. The 
terminal restarts.

No action.

RE000010 RECOVERY 
ATTEMPT: CHECK 
NETWORK 
CONNECTION

The terminal tried to get an IP 
address via DHCP, but detected a 
connectivity problem. This can be 
caused by a network cable not 
securely connected to the unit. 

1. Check the network cable 
connection to the 
terminal. If the green link 
light on the back of the 
terminal is on, the 
terminal is properly 
connected.

2. If the network cable is 
secure, check physical 
network cable 
connections back to the 
hub.

MS000001 COULD 
NOT MOUNT FILE 
SYSTEM

The firmware could not mount the 
file system. The terminal stops 
operating.

Contact NCD Technical 
Support.

MS000002 NVINFO 
BLOCK NOT FOUND

The MAC address (the low-level 
network ID of the terminal) has been 
lost. The terminal stops operating.

Contact NCD Technical 
Support.

MS000005 DID NOT 
FIND NVINFO 
BLOCK

The MAC address (the low-level 
network ID of the terminal) has been 
lost. The terminal stops operating.

Contact NCD Technical 
Support.

MS000006 FAILURE 
READING NVINFO 
BLOCK

The MAC address (the low-level 
network ID of the terminal) and 
serial number have been lost. The 
terminal stops operating.

Contact NCD Technical 
Support.

Error and Status Messages (continued)

Message Description Recommended Action
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MS000007 UNABLE 
TO READ NV 
STORAGE

The MAC address (the low-level 
network ID of the terminal) and 
serial number have been lost. The 
terminal stops operating.

Contact NCD Technical 
Support.

MS000008 MAC 
ADDRESS 
CHECKSUM 
FAILURE

The MAC address (the low-level 
network ID of the terminal) and 
serial number have been lost. The 
terminal stops operating.

Contact NCD Technical 
Support.

MS000011 FAILED TO 
REGISTER NFTL

The file system failed to load 
low-level routines.

Contact NCD Technical 
Support.

MS000012 FAILED TO 
REGISTER DOCSOC

The file system failed to load 
low-level routines.

Contact NCD Technical 
Support.

MS000013 FAILED TO 
REGISTER DOC200

The file system failed to load 
low-level routines.

Contact NCD Technical 
Support.

MS000019 WARNING: File has no CRC 
(Cyclical Redundancy Code–refers 
to checksum functions) installed; 
unable to verify CRC. Will continue 
to load and execute code.

No action.

MS000020 Incorrect product file. Fails to load, 
displays error message and stops 
operating.

Contact NCD Technical 
Support.

MS000021 Incorrect file type. Fails to load, 
displays error message and stops 
operating.

Contact NCD Technical 
Support.

MS000022 Bad record checksum. Fails to load, 
displays error message.

Contact NCD Technical 
Support.

MS0000014 FAILED 
TO MOUNT FLASH 
FOR READ

The firmware could not mount the 
file system. The terminal keeps 
trying to recover.

Contact NCD Technical 
Support.

Error and Status Messages (continued)

Message Description Recommended Action
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MS0000015 FAILED 
TO PARSE FILENAME

The firmware had an error 
processing the name of a file to be 
loaded. The terminal keeps trying to 
recover.

If the error persists, contact 
NCD Technical Support.

MS0000018 FAILED 
TO DISMOUNT FILE 
SYSTEM

The terminal could not dismount the 
file system after a read operation. 
The terminal keeps trying to recover.

If the error persists, contact 
NCD Technical Support.

MS207180 FAILED TO 
OPEN FILE TO READ

The terminal could not load the file 
containing the Windows CE code, 
wbt.bin. The terminal keeps trying 
to recover.

If the error persists, contact 
NCD Technical Support.

MS107180 FAILURE 
ON READ

The terminal could not load the file 
containing the Windows CE code, 
wbt.bin. The terminal keeps trying 
to recover.

If the error persists, contact 
NCD Technical Support.

MS007180 FILE LOAD 
FAILED

The terminal could not load the file 
containing the Windows CE code, 
wbt.bin. The terminal keeps trying 
to recover.

If the error persists, contact 
NCD Technical Support.

SE000012 UNABLE 
TO READ NV 
STORAGE

The MAC address (the low-level 
network ID of the NCD ThinSTAR) 
and serial number have been lost. 
The unit stops operating.

Contact NCD Technical 
Support.

SE000014 
KEYBOARD 
CONTROLLER 
ERROR

Keyboard controller module on the 
circuit board did not pass diagnostic 
test.

1. Try a different keyboard.
2. If the error persists, 

contact NCD Technical 
Support.

SE000016 NETWORK 
CONTROLLER 
FAILURE

The network controller failed 
diagnostic tests.

Contact NCD Technical 
Support.

Error and Status Messages (continued)

Message Description Recommended Action
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SE000017 FLASH 
SYSTEM REQUIRES 
FACTORY REWORK - 
PLEASE CONTACT 
NCD

The terminal has outdated flash 
memory.

Contact NCD Technical 
Support.

SE000019 FLASH 
SYSTEM REQUIRES 
FACTORY REWORK - 
PLEASE CONTACT 
NCD

The terminal has an outdated flash 
memory.

Contact NCD Technical 
Support.

SE000020 MARCH 
FAILURE FOUND 
A5A5A5A6 exp 
A5A5A5A5 at 
40122040

A memory test failed. There may be 
a problem with the memory or with 
the SIMM or DIMM in the terminal

1. Open the unit (refer to 
Appendix B). 

2. If there is a SIMM or 
DIMM installed, it may 
be defective; replace it 
with another SIMM or 
DIMM. See Appendix B 
for the type of DIMM or 
SIMM to use. If the error 
persists, contact NCD 
Technical Support.

SE000030 CANNOT 
CHANGE NVINFO 
DUE TO VERSION 
MISMATCH

When the MAC address or serial 
number is changed, the info block is 
not a version 2 or version 3. Should 
be seen in manufacturing only.

Contact NCD Technical 
Support.

SM000001 SAFE 
BOOT ENABLED

STATUS MESSAGE: The Safe Boot 
mode has been enabled by pressing 
F5. The terminal will use the default 
640x480 display resolution.

No action.

Error and Status Messages (continued)

Message Description Recommended Action
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APPENDIX C

Appendix C: Tips for Administration via NCD 
ThinPATH Manager

This appendix summarizes the effects of installing the optional NCD 
ThinPATH Manager product for central administration. It gives 
information that can help you prepare your users for changes they may 
observe. Details for the NCD ThinPATH Manager are in separate 
documentation for that product.

Users may see these changes after you use NCD ThinPATH Manager 
tools:

Q The terminal may restart automatically.

You can restart a group of terminals, all terminals, or one terminal 
from a central location. You can set this to happen immediately or 
after the terminal logs off or disconnects the last active connection.

Q The terminal may go into a soft powerdown state.

You can set an additional level of power savings (one that is not 
available from the terminal itself). In the Configuration Tool, you 
can set this option on the Management > Power tab, which puts 
the terminal into a soft powerdown state. This feature is not 
available for an NCD ThinSTAR 200 terminal.

Q The Connection Manager may display new connections or may 
eliminate connections.

You can create connections and distribute them to multiple 
terminals. Users see these new connections when they restart.

You can also remove all connections of a type (for example, all 
RDP connections or all ICA connections).
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Q It may be impossible to go to Terminal Properties.

You can disable F2 so that users cannot go to Terminal Properties.

Q The Configure tab may disappear.

You can disable the Configure tab on the Connection Manager so 
that users cannot change connection definitions.

Q Properties may change.

From a central location, you can use the NCD ThinPATH Manager 
Configuration Tool to change any property except the pointer speed 
and the static IP address. With the Web Configuration Tool, you can 
change these properties if a password is configured and you know 
the password.

Q The password may change.

You can reset a terminal’s password. 

Q Different hotkeys may be set.

You can define different hotkeys.

Q Some keyboard keys may start in a different state.

On the Management > System tab, you can configure the startup 
state of the keyboard so that Num Lock, Caps Lock, and Scroll 
Lock are enabled or disabled.

Q A user may have a different limit on the number of active 
sessions.

In the base product, the number of active sessions allowed depends 
on the amount of memory in the terminal. You can override this 
limit and restrict the number of sessions.

Q During setup, the Setup Wizard may present only two 
screens—the welcome screen and the license agreement—and 
the terminal may restart.

Since you are configuring properties globally, the other screens are 
not needed if the monitor is DDC-compliant, DHCP is detected, 
and an NCD ThinPATH Manager configuration file is sent to the 
terminal. If properties have changed, a restart occurs.
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Secondary Domain 
Controller (BDC)

A Windows NT Server that handles the same functions as a 
Primary Domain Controller (PDC) if the PDC is unavailable. 
See also domain controller.

Boot ROM See NCD ThinSTAR Boot Software.

booting The process of loading the startup programs into a terminal after 
it has been turned on or restarted.

client A device or software on a network that accesses services, 
applications, or data provided by a server. See also thin client.

connection A communication session between a client device and a server 
by means of a session protocol. An NCD ThinSTAR terminal 
communicates with a Terminal Server by means of the RDP 
protocol or the Citrix ICA protocol. You can define any number 
of connections on an NCD ThinSTAR terminal.

DDC Display Data Channel. DDC allows a display monitor to inform 
the host system about its identity and communicate additional 
levels of display capabilities.

desktop The working area of your screen.

DHCP Dynamic Host Configuration Protocol. A network service that 
dynamically assigns valid IP addresses to network devices as 
they start up. DHCP can also provide machines with valid 
subnet mask values, the IP addresses of gateway devices, DNS 
servers, and WINS server IDs. See also subnet mask, gateway, 
and DNS.
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DNS Domain Name System. A distributed database and utilities for 
defining TCP/IP domains and mapping domain names to IP 
addresses. See also domain and fully qualified domain name.

domain A set of network devices that are managed together. NCD 
networking involves DNS domains and Windows NT domains.

A DNS domain is a TCP/IP construct that defines hierarchical 
groups of devices on the Internet. It is a segment of the Internet 
and is given a unique, official name by InterNIC, the 
organization that administers Internet names and IP addresses.

A Microsoft Windows NT domain is a unique group of 
Windows NT Servers and workstations that the network 
administrator defines for centralized administration.

See also domain controller, DNS, and fully qualified domain 
name.

domain controller A Windows NT Server maintains the master database for a 
Microsoft domain (see domain). The database identifies users 
and systems, both of which may be members of the domain. The 
domain controller authenticates domain logons and maintains 
the Windows NT domain’s security policy.

Ethernet A popular network protocol (IEEE 802.3) and a physical 
channel for transmitting data over coaxial, twisted-pair, or 
fiber-optic cable.

Ethernet address The low-level address that the physical Ethernet network uses. 
Each device on the Ethernet has a unique physical address 
assigned by the IEEE and the device vendor. This is also called a 
MAC address or NIC ID.

focus Being in a mode to receive input from the keyboard or mouse. 
Used in reference to tasks on the desktop. While several tasks 
may be currently active, only one has the focus at a time.
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fully qualified domain 
name

A name for a network device that combines its hostname and its 
DNS domain name. For example, suppose that the domain 
acctg.biggcorp.com has a device whose hostname is 
SaleServer. The device’s fully qualified domain name is 
SaleServer.acctg.biggcorp.com. See also DNS and domain.

FQDN See fully qualified domain name.

gateway A computer that attaches to two or more networks and routes 
packets from one to the other.

host A server on the network, such as a Windows NT server.

hostname A string used to uniquely identify a device on a network. It is 
part of the domain name.

ICA Independent Computing Architecture. A remote session 
protocol developed by Citrix Systems for communication 
between terminals and servers running Citrix WinFrame or 
Citrix MetaFrame.

Internet The collection of networks and gateways that use the TCP/IP 
protocol family and function as a single, cooperative virtual 
network that connects many businesses, universities, and 
government facilities.

IP Internet Protocol. Part of the TCP/IP family of protocols. 
Responsible for addressing and routing datagrams at the 
network level.

IP address Internet Protocol address. Internet addresses are currently have 
four numbers separated by periods, for example, 127.0.0.1. The 
IP address identifies a device on the network so that it can 
participate in the IP network using the TCP/IP protocols.

LAN Local Area Network. A network that connects devices over 
relatively short distances, typically within a building or campus.

MetaFrame Server software from Citrix Systems that runs on the Microsoft 
Windows 4.0, Terminal Server Edition operating system and 
provides connectivity for NCD ThinSTAR terminals through the 
ICA protocol.
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Microsoft Windows CE A compact Microsoft operating system, originally developed for 
handheld devices, that has been adapted for use in thin client 
devices. See also thin client.

Microsoft Terminal 
Server Client

An implementation of Microsoft’s RDP remote session protocol. 
It enables terminals and Terminal Servers to exchange graphical 
application input and output. See also client and Terminal 
Server.

NCD ThinSTAR 200
NCD ThinSTAR 300

NCD’s Windows-based terminals.

name server A host that provides translation between network hostnames and 
IP addresses. See also DNS.

NCD ThinSTAR Boot 
Software

Low-level code that initiates the startup process of an 
NCD ThinSTAR terminal when it is powered up or restarted.

NCD ThinSTAR 
Management Service 
(TMS)

An NCD utility that runs on a Windows NT server. Can be 
configured to automatically replace outdated or corrupt 
Operating Software on terminals.

NetBIOS A communication protocol developed for networks of Microsoft 
platforms. NetBIOS identifies devices by the ID number of their 
NICs (Network Interface Cards). A device’s hostname is 
mapped to its NIC IDs.

The WINS name resolution service can map NetBIOS 
hostnames to IP addresses so that Microsoft platforms can 
communicate over TCP/IP networks.

network server See Windows NT server.

ping command A command for testing connectivity between a terminal and 
another network host.

PPP Point-to-Point Protocol. The NCD dial-up client uses this 
protocol to establish a connection with a network server over a 
modem.

PPPD Point-to-Point Protocol Daemon. A service that the PPP client 
communicates with.
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Primary Domain 
Controller

See domain controller.

published application An application configured by the system administrator for 
remote users. With published applications, the user accesses 
only the specified application and does not need to know the 
address of a specific server to create a connection.

RAS Remote Access Service. A service on Windows NT hosts that 
enables users to dial into a Windows NT network with a modem.

RDP Remote Desktop Protocol, a proprietary communication 
protocol that Microsoft Corporation developed so that 
Windows-based Terminals, such as the NCD ThinSTAR 
terminal, could communicate with Terminal Servers.

registered Recorded in a database called the Registry in Microsoft 
Windows operating systems. A client must be registered in the 
terminal’s Registry to be available on the terminal. 

Registry A database integral to Microsoft Windows operating systems. It 
is used to record and track the presence and state of applications, 
hardware, and configuration files.

server A computer or device that provides shared resources to network 
users.

SNMP agent Software on a terminal that reports terminal settings to the 
SNMP manager (if an SNMP manager is installed). The SNMP 
agent is read-only by default. The full list of SNMP values is in 
the NCD-THINSTAR.MIB.txt file, which is installed by 
default in \Program Files\NCD\ThinSTAR Management.

You need the NCD ThinPATH Manager Configuration Tool to 
enable SNMP to write and change terminal settings.

subnet A physical network within a larger IP network. Allows a site to 
use a single Internet network for multiple physical networks.

subnet mask The format of an IP address that shows which part of the address 
identifies the subnet and which part identifies a particular 
machine.
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TCP/IP Transmission Control Protocol/Internet Protocol. A common 
name for the Internet protocol family.

terminal A set of input and output devices, such as a monitor and 
keyboard, that access data and/or computing services on a server 
across a network.

Terminal Server A server running the Microsoft Windows NT Server 4.0, 
Terminal Server Edition operating system. It allows 
Windows-based terminals like the NCD ThinSTARs to run 
Windows NT applications remotely.

Terminal Server host A computer running the Microsoft Windows NT Server 4.0, 
Terminal Server Edition operating system. See also Terminal 
Server.

thin client Terminal software that manages input and output between a 
user’s input/output devices (keyboard, mouse, and monitor) and 
a server using a remote session protocol. See thin client device.

thin client device Hardware that runs thin client software. See thin client.

ThinSTAR See NCD ThinSTAR 200/300.

ThinSTAR Management 
Service (TMS)

See NCD ThinSTAR Management Service (TMS).
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About tab 6-35
active sessions allowed C-2
address

gateway 4-7
mode, selecting 6-11
static 4-8, 6-11
static IP C-2

address. See also IP address.
Addresses tab 6-33
application 2-1

published, Citrix ICA 5-10
starting instead of Windows NT desktop 5-6

Audio tab 6-21
audio, configuring 6-21
authentication in Windows NT domains 3-4
auto-locate broadcast 5-10
automatic recovery 2-4, 3-5, 3-6, 3-20

and DHCP 3-8
requirements 3-16, 3-20

autostart connection
setting 5-42
stopping 5-43

B
Best Available Using DDC 4-9, 6-8, 6-10
boot error

alert tones B-6
flashes B-7

C
CE (Microsoft Windows CE) 2-4
Change Password tab 6-17, 6-18
Citrix ICA client

global client settings 5-21
hotkeys 5-22

primary Citrix server 5-10
published application 5-10

Citrix ICA connection 5-1
adding 5-9
client name 5-23
colors 5-23
dial-in 2-7
disconnecting 5-26
logging off 5-26
palette device 5-23
printing 3-13
server locations 5-24
starting 5-25
stopping 5-26
wizard 5-9

Citrix ICA dial-in connection 5-16
Citrix ICA protocol 3-6, 3-13
Citrix MetaFrame 2-1, 3-6

configuring local printing 3-13
Citrix WinFrame 3-6

configuring local printing 3-14
Citrix WinFrame operating system 2-1
client 2-3

default 4-5, 6-30
protocol 2-4, 2-7
selecting in Connection Manager 5-38
software 2-4

Clients tab 6-30
communication session 2-4, 2-7, 2-8, 5-1
configuration

file, NCD ThinPATH Manager C-2
configuration at setup 4-1, 6-2
Configure tab 6-8

enabling 6-30
connection

adding from Connection Manager 5-38
autostart, setting 5-42

Index
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autostart, stopping 5-43
Citrix ICA. See Citrix ICA connection.
default 5-41
deleting from Connection Manager 5-39
diagnostics 6-28
editing in Connection Manager 5-39
hot keys for switching connections 6-25
LAN 5-1
logical 5-1
low speed 5-4
modem. See NCD dial-up connection or ICA 

dial-in connection.
NCD dial-up. See NCD dial-up connection.
RDP. See RDP connection.
removing all of a type with NCD ThinPATH 

Manager C-1
stopping autostart connection 5-43
stopping from Connection Manager 5-40
type 6-26
wizard, Citrix ICA connection 5-9
wizard, RDP connection 5-3

Connection Manager 2-8
adding connection 5-38
autostart connection, setting 5-42
autostart connection, stopping 5-43
Configure tab 6-8
Configure tab, enabline 6-30
default connection 5-41
deleting connection 5-39
displaying 5-37
stopping connection 5-40

Create Password tab 6-15

D
DDC-compliant monitor C-2
DDC-compliant monitors 4-9
default(s)

client 4-5, 6-30
connection 5-41
factory, changing 2-5
factory, resetting 4-3, 6-7
properties, list of 6-7
Terminal Properties access 6-18

deleting connection 5-39
device name resolution 4-8

DHCP 3-5, 3-8, 6-8, 6-11, 6-12
and automatic recovery 3-8
and automatic updates C-2
and forced recovery 3-20
and Management Server 3-16
and TMS 3-16
enabling or disabling 6-11
installing on Windows NT server 3-8
timeout 6-8, 6-27

diagnostics, connection 6-28
dial-in connection, Citrix ICA. See Citrix ICA 

dial-in connection.
dial-up connection, NCD. See NCD dial-up 

connection.
disconnect 2-8
disconnecting

Citrix ICA connection 5-26
RDP connection 5-8

display
modifying appearance 6-10
refresh frequency 6-10
refresh rate 4-9
safe mode B-12
unreadable, what to do B-2

Display tab 6-8, 6-10
DNS 3-5, 3-10, 4-7, 6-12

server 4-8
domain

concepts 3-2
Internet 3-3
TCP/IP 3-3
Windows NT 3-4, 5-5

user authentication 3-4

E
effects of using C-1
Energy Star compliant monitor 6-29
Enter Password tab 6-16
error

boot B-6, B-7
terminal does not operate B-2
unreadable display B-2
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F
factory defaults 2-5, 4-3

resetting 6-7
flash memory 2-3, 3-20
flashes, boot error B-7
forced recovery 3-20

G
gateway 6-12
gateway, specifying 4-7
global ICA client settings 5-21
Graphics tab 6-35

H
Hardware tab 6-31
hardware version 6-31
host name 3-3

mapping to IP address 3-5, 6-12
hotkeys

Citrix ICA 5-22
defined through NCD ThinPATH 

Manager C-2
for displaying Terminal Properties 6-3
for switching connections 6-25

Hotkeys tab 6-25

I
ICA client. See Citrix ICA client.
Input tab 6-9
installed software 6-32
installing

DHCP 3-8
NCD ThinSTAR Management Service 

(TMS) 3-16
SNMP

agent 2-6
Internet domain 3-3
Inventory tab 6-31
IP address 4-8, 6-8, 6-12

and host name 3-3
if DHCP unavailable 3-5
mapping to host name 6-12

K
key repeat 6-9
keyboard

configuring 6-9
locale 6-9

keyboard, configuring 6-9

L
LAN

connection 5-1, 6-26
mode 6-26

language 6-30
locale, Windows Terminal Server 6-30
log off 2-8

Citrix ICA connection 5-26
RDP connection 5-8

low speed connection 5-4

M
Management Server 2-2, 3-16, 3-17

and TMS 3-16
timeout 6-27

Management Server, specifying 6-24
memory

flash 2-3, 3-20
installing A-2, A-11
RAM 2-3
specifications A-2, A-10
testing A-9, A-18

microphone 6-8, 6-21
Microsoft RAS (Remote Access Service) 3-6
Microsoft Terminal Server client. See RDP 

client.
Microsoft Windows CE 2-4
Microsoft Windows NT 4.0, Terminal Server 

Edition operating system 2-1
Misc. tab 6-34
modem

callback 5-27
connection. See NCD dial-up connection or 

ICA dial-in connection.
monitor 4-9

DDC-compliant C-2
Energy Star compliant 6-29
power 6-29
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mouse
button actions 6-9
configuring 6-20

mouse, configuring 6-9
mute speaker 6-21

N
name resolution service 3-10, 4-7

choosing 3-11
DNS 3-10, 6-12
enabling 6-12
primary server 4-8
secondary server 4-8
servers resolving names 4-8
WINS 3-10, 6-12

Name Services tab 6-34
NCD dial-up client 2-4, 2-7, 5-2, 5-29
NCD dial-up connection 3-6, 5-4, 6-26

adding 5-27
IP addresses 3-5
protocol session 5-34
selecting 6-26
starting 5-35
stopping 5-37

NCD ThinPATH Manager 1-1, 2-6, C-1
configuration file C-2

NCD ThinSTAR 200
installing memory A-2

NCD ThinSTAR 300
installing memory A-10

NCD ThinSTAR core software 2-4
NCD ThinSTAR Management Service 

(TMS) 2-2, 3-6, 3-15
functionality 3-15
installing 3-16
upgrade log 3-19
upgrade policy 3-17

NCD ThinSTAR Operating Software 2-4, 3-6
NCD ThinSTAR terminal

prerequisites 4-1
restarting 4-3
starting 4-2, 4-3
steps after starting 4-2

NCD ThinSTAR Terminal Properties 2-8
NCD-THINSTAR.MIB.txt file 2-6

network concepts 3-2
network connection

timeouts 6-27
type 6-26

network services
DNS 3-10
name resolution 3-10
RDP 3-12
required 3-5
TCP/IP 3-7
WINS 3-10

network speed 6-26
Network tab 6-8, 6-11, 6-26

O
Operating Software

automatic recovery 3-16

P
password

resetting with NCD ThinPATH Manager C-2
ping command 6-27, 6-28
pointer speed C-2
pointer speed, setting 6-20
Pointer tab 6-20
power 6-8

monitor 6-29
screen saver 6-10
terminal C-1
timeouts 6-29

Power tab 6-29
Powerdown Timeout 6-29
PPP (point-to-point) protocol 2-7
PPP service 5-4
primary server

for name resolution 4-8
printing to local printers during ICA 

sessions 3-13
problem-solving

terminal does not operate B-2
unreadable display B-2

protocol
session 2-7

published application 5-10
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RAM memory 2-3
RDP connection 5-1

adding 5-3
disconnecting 5-8
logging off 5-8
starting 5-7
stopping 5-8

RDP protocol 3-6, 3-12, 5-3
recovery

automatic 3-20
forced 3-20

remote session protocol 3-6, 3-12
reset to defaults 6-7
resolution

name. See name resolution service
screen 6-10

restarting
terminal C-1

restarting NCD ThinSTAR terminal 4-3

S
safe boot mode B-12
screen

resolution 6-10
saver 6-8, 6-10

secondary server
for name resolution 4-8

serial connection 5-4
server locations, Citrix ICA connections 5-24
Server tab 6-24
session

ending 2-8
session limits C-2
session protocol 2-7
Setup Wizard 6-7, C-2
setup wizard 6-2
SNMP

agent 2-4, 3-6
manager 2-4

soft powerdown state C-1
software

installed 6-32
update requirements 3-16
upgrades 3-17

Software tab 6-32
speaker

mute 6-21
volume 6-21

speaker volume 6-21
starting NCD ThinSTAR terminal 4-3
static addresses 6-11
static IP address 6-11, C-2
subnet 3-2

mask 4-7, 6-12
Suspend Timeout 6-29

T
TCP/IP 2-7, 3-5

configuring 3-7
configuring for Windows NT 3-7
domain 3-3, 4-8

terminal memory
installing A-10
specifications A-10
verifying A-9, A-18

Terminal Properties 4-1, 6-2
access to fields and tabs 6-18
addresses, configuring 6-11
cancelling changes 6-4
configuration after setup 6-2
connection hotkeys 6-25
displaying 6-3
exiting 6-4
keyboard, configuring 6-9
mouse, configuring 6-9
name resolution service, enabling 6-12
network connection 6-26
password 6-3, 6-15
resetting factory defaults 4-3, 6-7
saving changes 6-4
security 6-15
Setup Wizard 4-1
tabs

Display tab 6-10
Input tab 6-9
Inventory > About 6-35
Inventory > Graphics 6-35
Inventory > Hardware 6-31
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Inventory > Network Settings > 
Addresses 6-33

Inventory > Network Settings > Name 
Services 6-34

Inventory > Software 6-32
Inventory >Network Settings > Misc. 6-34
Inventory tab 6-31
Management > Audio 6-21
Management > Clients 6-30
Management > Hotkeys 6-25
Management > Network 6-26
Management > Pointer 6-20
Management > Power 6-29
Management > Security > Change 

Password 6-17, 6-18
Management > Security > Create 

Password 6-15
Management > Security > Enter 

Password 6-16
Management > Server 6-24
Network tab 6-11
Security > Create Password 6-15

thin client 2-3, 2-7
computing 2-1
device 2-3

ThinSTAR Management Service (TMS). See 
NCD ThinSTAR Management Service 
(TMS).

timeout
DHCP 6-8, 6-27
Management Server 6-27
powerdown 6-29
suspend 6-29

tones, error B-6
troubleshooting

boot error alert tones B-6
boot error flashes B-7
failure to connect to a host 5-7
terminal does not operate B-2
TMS log 3-19
unreadable display B-2

U
unreadable display, what to do B-2
update requirements 3-16

upgrade
policy 3-17
TMS log 3-19

V
version, hardware 6-31
volume

mute 6-21
speakers 6-21
testing 6-21

W
Windows CE operating system 2-3, 2-4
Windows NT domain

for RDP connection 5-5
global authentication 3-4
local authentication 3-4
user authentication 3-4

Windows NT server
configuring TCP/IP 3-7
installing and configuring DHCP 3-8

Windows RAS/TAPI subsystem 5-29
Windows Terminal Server 1-1, 2-7, 5-1, 5-4

and client protocols 3-6
configuring RDP 3-12
locale 6-30

WINS 3-5, 3-10, 4-7, 6-12
WTS Connection Wizard 5-3


	Contents
	Chapter 1: About This Guide
	Chapter 2: NCD Thin Client Computing
	What Is NCD Thin Client Computing?
	Thin Clients and Thin Client Devices
	NCD�ThinSTAR Operating Software
	Terminal Management Options
	Communication Sessions
	Navigation Paths

	Chapter 3: NCD�ThinSTAR Network Management
	Subnets and Domains
	Network Services

	Chapter 4: Terminal Startup and Setup
	Prerequisites
	Starting an NCD�ThinSTAR Terminal
	Configuring the Terminal at Setup

	Chapter 5: Connections
	Introduction to Connections
	RDP Connections
	ICA Connections
	NCD Dial-Up Connections
	Managing Connections

	Chapter 6: Terminal Properties
	Introduction to Terminal Properties
	Resetting Values to Factory Defaults
	Input Properties
	Display Properties
	Network Properties
	Management Properties
	Inventory Properties

	Appendix A: Adding Memory to Terminals
	Installing Memory—NCD ThinSTAR 200
	Installing Memory—NCD ThinSTAR 300

	Appendix B: Troubleshooting
	Problems and Solutions
	Error Codes and Messages

	Appendix C: Tips for Administration via NCD ThinPATH Manager
	Glossary
	Index

